## Contents

1. Tekla Structures 2024 release notes ......................................................... 7

2. More reliable drawing cloning ................................................................. 9

3. New custom colors in drawings and printing line property improvements .............................................. 12
   3.1 How to access the new color palette ....................................................... 14
   3.2 Add new custom colors ........................................................................ 18
   3.3 Save added custom colors to a palette .................................................... 20
   3.4 Modify a saved color palette ................................................................. 20
   3.5 Assign custom colors to drawing objects ............................................... 21
   3.6 Custom colors and other line property improvements in printing ........ 23
   3.7 Custom colors in Template Editor .......................................................... 29
   3.8 Custom colors in drawing hatches ............................................................ 30
   3.9 Changes in advanced options related to colors ........................................ 31
   3.10 Other changes in colors ....................................................................... 32
   3.11 Limitations in drawing colors ............................................................... 32

4. New font height metric option for printing and exporting drawings: CAP height ........................................... 35

5. New DGN export option for drawings ......................................................... 39

6. New way to handle empty marks and associative notes .............. 43

7. Improvements in drawing dimensions .................................................... 45
   7.1 New rounding options in dimension properties ....................................... 45
   7.2 Improvements in view-level dimensioning ............................................. 47
   7.3 Dimensions in rebar mark pull-out pictures ........................................... 49

8. Other improvements in drawings ............................................................. 50
   8.1 Keeping needed drawing versions .......................................................... 50
   8.2 Fabrication drawings - use copying and pasting in model path ............. 52
   8.3 Arial is the new default font in drawings ............................................... 52
   8.4 Changes in handling printing settings ..................................................... 52
   8.5 New categories in Drawing content manager ......................................... 53
   8.6 Length attributes in rebar marks and tags ............................................. 53
8.7 Rebar pull-out pictures and marking - add custom properties in marks................................................................................................................54
8.8 Rebar group marking - speed improvements.............................................. 54
8.9 Improvements in Rebar mesh view creator.................................................54
9 Drawing property pane improvements................................................. 55
9.1 New object types in drawing property pane.............................................. 55
9.2 Copy to clipboard - new way to copy object properties in property pane.................................................................................................................. 57
9.3 Improved property panes for creating detail views and section views...57
9.4 Possibility to type in user-defined attributes..............................................59
9.5 Improved frames in drawing annotation objects........................................60
10 More efficient way copy object properties in the property pane: Copy to clipboard.............................................................. 62
10.1 Keyboard shortcuts for Copy to clipboard and Paste commands ............ 63
10.2 Control the visibility of the Copy to clipboard and Copy to other object buttons in the property pane............................................................ 64
11 New interactive model view rotation................................................. 65
12 Snap to parallel points & snap to object faces.............................................. 67
12.1 Snap to parallel points....................................................................................67
12.2 Snap to perpendicular and intersection points on object faces ............. 69
13 Renewed interactive bolt creation with preview........................................ 72
14 Improved in-app instructions for self-sufficient learning experience..........................74
15 Other modeling improvements................................................................. 76
15.1 Changes in saving macros.............................................................................. 76
15.2 Change in controlling pour unit visibility in Organizer.................................. 77
15.3 Updates in the Compare commands.............................................................. 78
15.4 Changes in non-linear model object solids.................................................. 78
16 Reinforcement improvements......................................................................79
16.1 Renewed bar generation method for rebar sets......................................... 79
16.2 Updates in rebar geometry handling in numbering..................................... 81
16.3 Update in automatic attachment of rebar set bars to concrete parts...82
16.4 User-defined attributes of bar ends............................................................... 82
16.5 Improvements for spiral reinforcing bars.................................................... 83
16.6 Other reinforcement updates....................................................................... 83
<table>
<thead>
<tr>
<th>Chapter</th>
<th>Title</th>
</tr>
</thead>
<tbody>
<tr>
<td>17</td>
<td>New IFC property set definition - control all hidden, hard-coded, and buildingSmart properties</td>
</tr>
<tr>
<td>17.1</td>
<td>Add a new custom property set</td>
</tr>
<tr>
<td>17.2</td>
<td>Add properties to a property set</td>
</tr>
<tr>
<td>17.3</td>
<td>Add a buildingSMART property set</td>
</tr>
<tr>
<td>18</td>
<td>Trimble Connect: BCF Topics replace ToDos in Tekla Structures</td>
</tr>
<tr>
<td>18.1</td>
<td>Create and modify BCF topics</td>
</tr>
<tr>
<td>19</td>
<td>More accurate model representation in the model upload to Trimble Connect</td>
</tr>
<tr>
<td>20</td>
<td>New model export format - 3D PDF</td>
</tr>
<tr>
<td>21</td>
<td>Import from Tekla Structural Designer</td>
</tr>
<tr>
<td>21.1</td>
<td>Import portal frame connection information</td>
</tr>
<tr>
<td>21.2</td>
<td>Import column base plates</td>
</tr>
<tr>
<td>22</td>
<td>Other interoperability improvements</td>
</tr>
<tr>
<td>22.1</td>
<td>Improvements in reference models</td>
</tr>
<tr>
<td>22.2</td>
<td>IFC export improvements</td>
</tr>
<tr>
<td>22.3</td>
<td>Improvements in point clouds</td>
</tr>
<tr>
<td>22.4</td>
<td>Improved Layout manager workflow</td>
</tr>
<tr>
<td>22.5</td>
<td>Improvements in DSTV/NC</td>
</tr>
<tr>
<td>22.6</td>
<td>Improvements in BVBS export</td>
</tr>
<tr>
<td>22.7</td>
<td>Improvements in ELiPLAN export</td>
</tr>
<tr>
<td>22.8</td>
<td>Updates in interoperability links</td>
</tr>
<tr>
<td>23</td>
<td>Tekla Model Sharing: selection for data storage location</td>
</tr>
<tr>
<td>24</td>
<td>Integrated link to Tekla Tedds for simple connections</td>
</tr>
<tr>
<td>24.1</td>
<td>Start Tekla Tedds integration</td>
</tr>
<tr>
<td>24.2</td>
<td>Working with Tekla Tedds Integrator</td>
</tr>
<tr>
<td>24.3</td>
<td>Tekla Tedds user-defined attributes</td>
</tr>
<tr>
<td>24.4</td>
<td>Tekla Tedds representation</td>
</tr>
<tr>
<td>25</td>
<td>Integrated Bridge creator for bridge design</td>
</tr>
<tr>
<td>26</td>
<td>Improvements in components</td>
</tr>
<tr>
<td>26.1</td>
<td>Concrete components</td>
</tr>
<tr>
<td>26.2</td>
<td>Steel components</td>
</tr>
</tbody>
</table>
27 Changes in advanced options.................................................. 138
  27.1 New advanced options.......................................................... 138
  27.2 Changed advanced options.................................................... 141
  27.3 Obsolete advanced options.................................................... 141
  27.4 List of obsolete advanced options across Tekla Structures versions...... 142
28 Tekla Structures 2024 administrator's release notes............143
  28.1 Administrator's release notes: Model templates in version update ..... 143
  28.2 Administrator's release notes: Applications & components catalog maintenance ................................................................. 148
  28.3 Administrator's release notes: Ribbon updates........................................ 149
  28.4 Administrator's release notes: New DGN export for drawings......... 150
  28.5 Administrator's release notes: New categories in Drawing content manager.............................................................................. 151
  28.6 Administrator's release notes: New custom colors in drawings and printing line property improvements.................................................. 151
      Enable the new color palette dialog box................................................................. 151
      Update advanced options for custom RGB colors................................................ 152
      Update templates for custom RGB colors............................................................... 153
      Update old drawing property files containing old color codes................................. 153
  28.7 Administrator's release notes: Reinforcement improvements.............. 154
      Update Rebar shape manager rules........................................................................... 154
      Update the environment for smoothing factor for rebar sets.................................. 155
      Update user-defined attributes of bar ends............................................................. 155
      Update rebar mesh sizes in rebar_config.inp............................................................ 155
  28.8 Administrator's release notes: Improvements in drawing dimensions. 156
      Updates for new rounding options in dimension properties...................................... 156
  28.9 Administrator's release notes: Updates in the Compare commands.....156
      Update custom report templates............................................................................ 156
  28.10 Administrator's release notes: New IFC property set definition - control all hidden, hard-coded, and buildingSmart properties............ 157
       Copy files from the common environment.................................................................. 157
       Create a new filter file for the IFC property set export............................................ 158
  28.11 Administrator's release notes: Arial is the new default font in drawings...................................................................................... 159
       Update your environment for the font change......................................................... 159
  28.13 Administrator's release notes: Changes to IFC property sets for Tekla PowerFab................................................................. 160
       Update your environment for changes to IFC property sets for Tekla PowerFab..... 161
  28.14 Administrator's release notes: Integrated link to Tekla Tedds for simple connections...................................................................... 161
       Enable the user interface for Tekla Tedds Integrator................................................. 161
28.15 Administrator's release notes: System and folder changes ............... 162
- Dll Com Analysis removed............................................................... 162
- Tekla internal bitmaps moved to ..\2024.0\bin\Env\Bitmaps................................. 162
- Tekla internal instructor pane texts moved to ..\2024.0\bin\Env\InstructorContent.. 163
- Standard and translation files for Tekla internal applications moved to bin folder.... 163
- Deprecation notice for removal of support for XS_SYSTEM and isolated files in extensions folders.................................................................................................................. 163
- .tsep installers removed from environment installers.......................... 163

28.16 Administrator's release notes: Miscellaneous general improvements.. 164
- New configuration for Tekla Platform partners........................................... 164
- Licensing improvements............................................................................ 164
- Changes in the Inquire Cast Unit report...................................................... 165
- Flange slope ratio added to UPN profiles...................................................... 165
- Improved visualization for non-foldable and broken chamfers.................. 165
- Changes to UDA tabs and default values...................................................... 166
- Prevent the copying of UDAs from the cutting part to the cut part............ 168
- Finish field in Floor Layout tool................................................................. 168
- New objects supported in Drawing property pane.................................... 168
- Configuration file for Multi-report generator........................................... 168
- Enhancements in the Management Console for Tekla Model Sharing........ 169

28.17 Administrator's release notes: Steel settings........................................... 170
Administrator's release notes: Steel components........................................ 170

28.18 Administrator's release notes: Concrete settings................................... 170
Administrator's release notes: Concrete components................................... 170

29 Localization release notes................................................................. 171

30 Disclaimer.................................................................................. 172
Welcome to Tekla Structures 2024!

Enjoy an easy and self-guided user experience with enhancements introduced in Tekla Structures 2024. Deliver the required documentation and model information efficiently using a wider variety of supported industry formats. Collaborate with ease and in compliance with your project’s specifications. Leverage the power of enhanced communication between all project stakeholders for more integrated, connected workflows.

Scroll down or use the PDF bookmarks to navigate to the features that interest you.

**Compatibility**

We suggest that you complete any unfinished models using your current version of Tekla Structures.

This version is not backwards compatible. When you create or save a model in Tekla Structures 2024, you cannot open it in older versions due to database differences.

See the hardware recommendations for information on supported operating systems.

**Administrator's release notes**

Advanced users should read the Tekla Structures administrator's release notes (page 143) for information on how to apply the additional customizations available in this release.

**Localization release notes**

Environment-specific changes are explained in the Localization release notes (page 171).

**Tekla Open API release notes**

The Tekla Open API release notes can be found in the Tekla Developer Center.
Release notes summary across Tekla Structures versions

The Release notes summary across Tekla Structures versions provides an overview to the new features and improvements in Tekla Structures versions and service packs for Tekla Structures version 2018 and newer. The summary is available in English only.

List of obsolete advanced options across Tekla Structures versions

The list of obsolete advanced options provides information about the advanced options that have become obsolete in Tekla Structures in version 2018 and newer.
Cloning is used frequently in drawings for creating fabrication drawings. In Tekla Structures 2024, when you use cloning to create assembly drawings, you now automatically get more correct results, so less adjusting is needed. And when the model changes, your drawings stay up to date better.

The improvements in the core cloning engine deliver enhancements to the following features:

- **The Smart create feature in fabrication drawings.** This feature has been improved focusing mainly on steel product drawings but concrete drawings also benefit.

- **The classic cloning feature for fabrication drawings in Document manager and Master drawing catalog.**

The quality of the documentation generated by the Smart create feature in fabrication drawings has been improved primarily for assembly drawings:

- Improved section view creation
- Improved placement of views and dimensions for parts and bolts

### Examples of cloning improvements

The following examples show how the annotation and view placement has been improved for similar assemblies with different amount of model objects.
More reliable drawing cloning
New custom colors in drawings and printing line property improvements

In Tekla Structures 2024, you can easily define an unlimited number of custom RGB colors for drawing objects and meet the related industry standards and regulatory requirements. Now you can color-code your objects in Tekla Structures drawings and then export or print the drawings WYSIWYG for stakeholders.

You can define custom RGB colors using the new color palette in editing mode.

You can use custom colors:
- throughout the drawing, drawing view, and drawing object level properties
- in the line properties in printing
• in the Template Editor templates
• for drawing objects in Tekla OpenAPI extension development

Custom RGB colors are also supported in the drawing export. The standard, hard-coded Tekla Structures colors are still available for use as well. The **Special** color option has been removed, as the functionality is now provided by custom colors. When loading old Tekla Structures drawings that use the **Special** color, Tekla Structures still shows that color in the drawings and outputs.

In the new color palette dialog box, you can select a standard or custom color to use and, in editing mode, also define and save a set of custom colors in a property file for easy reuse and sharing in a specific project, for example. Color property files can be placed in all the standard file locations such as project or firm folders. The saved custom color palettes will be available in all places where you might want to change the colors: for all drawing objects on all drawing property levels, for line properties in printing, and for template objects in Template Editor.

Example of the workflow you might want to use when applying the custom colors:

1. First create and save the custom color palettes in color editing mode for the needed purposes, for example, for a specific project.
2. Apply the defined custom colors to the drawing objects and to drawing templates.
3. Finally, define the printing output colors using the new custom colors and saved color palettes.
3.1 How to access the new color palette

You can access the color palette in any of the following ways:

- In drawing mode, go to the File menu and click Editors --> Color palette editor. Here, you can edit or add custom colors.

To switch between viewing modes, click the button. In the list mode, you can also see the names of the new custom colors.
In the property pane for drawing objects, click a color setting box. Here, you can select colors from the available palettes. To access color editing mode, click the **Edit colors** button at the top.
• In the drawing or view level dialog box for a drawing object, click the new selection button next to a color setting. Here, you can select colors from the available palettes. To access color editing mode, click the Edit colors button at the top.

• In the contextual toolbar for a drawing object, click the color setting box. Here, you can select colors from available palettes. To access custom color editing mode, click the Edit colors button at the top.
• In the **Print Drawings** dialog box, on the **Line properties** tab, click the button. The color palette is also displayed when you select **Custom** as the output color option. Here, you can select colors from the available palettes. To access custom color editing mode, click the **Edit colors** button at the top.

![Select color](image)

• In the edge chamfer default line settings: Go to the **File** menu, click **Settings** --&gt; **Options** --&gt; **Drawing objects**, and click the new selection button next to the edge chamfer **Line color** setting. Here, you can select colors from the available palettes. To access custom color editing mode, click the **Edit colors** button at the top.

• In a Template Editor template, double-click a shape object or a text object to display the object properties, and then click a color. Here, you can select and add colors.
3.2 Add new custom colors

Open the color palette editor:

- In drawing mode, go to the File menu and click Editors --> Color palette editor.

Add colors:

- In editing mode, click the Add new custom color button. In the displayed Add color dialog box, use the color slider on the left to go to the desired color, then pick the desired shade in the color area with the color picker. Alternatively, enter the exact RGB or HEX values. You can also give the color a name, if desired. When you are done, click OK.
Tekla Structures adds the color in the Custom section of the color palette dialog box. The color name is displayed when you point the custom color in the palette. Add all the desired colors in the same way. When you are done, save the added colors to a palette to ensure that they are kept.

**NOTE** If you add new custom colors in the color palette dialog box but do not save the color palette, Tekla Structures remembers the added custom colors in the current session. This means that if you close the color palette and later on open it again, you can still see the added colors. The added colors are
3.3 Save added custom colors to a palette

To save the custom colors that you have added in the Custom section in a palette, in editing mode, enter a name for the color palette file in the Custom box, and click Save.

The color palette files are saved as *.ColorPalette.xml files in the \attributes folder under the current model folder. You can save as many color palette files as you need and also place them in the firm and project folders for sharing.

The saved color palettes are available for all types of drawing objects on all drawing property levels, in printing, and for templates in Template Editor.

The custom colors that you use in the drawing objects are saved in the drawing database, whereas the custom colors that you use in the drawing, view or object level settings files are saved in the settings files. This means that removing a custom color that is currently used in a drawing object from the color palette does not affect any drawings or the saved color palette files.

3.4 Modify a saved color palette

You can edit a color, or remove an unnecessary color from a palette.

To remove a color, in color editing mode, open a color palette, click the color in the palette, and press Delete on the keyboard, or right-click the color and select Delete.
• To edit a color, right-click the color in the palette and select **Edit**.

When a palette is being modified, the palette name gets an asterisk (*) and the name is displayed in italics, for example, *My colors*. Click **Save** when you are done.

### 3.5 Assign custom colors to drawing objects

• To assign a custom color to a drawing object, click a color setting in a drawing object property pane or the selection button in a drawing object properties dialog box, select a saved color palette from the **Custom** list, and then click a custom color in the palette. Finally, click **Modify** in the properties to apply the changes.
If you want to use the same custom color for multiple objects, ensure that the property pane is open and select the objects in the drawing. "Varies" is shown in the color box if the colors differ and the colors for the objects are listed. Select the desired color from the palette, and click **Modify**.

If you added names for the custom colors, they are shown in list mode:
3.6 **Custom colors and other line property improvements in printing**

In Tekla Structures 2024, you have new options available for creating exactly the output that you need. On the **Line properties** tab, you can now:

- Select the desired output color option from the new **Color on output** list:
  
  **By object** - use the drawing object colors in output as they are
  
  **Custom** - map object colors to custom colors
  
  **Grayscale** - print in grayscale
  
  **No output** - skip printing of objects that have a certain color
• Show the selected output color and line thickness in the output preview.
• Select multiple rows by using Ctrl or Shift and then select a command from the context menu:

• Show changes immediately in the drawing preview. You can use the mouse wheel to zoom in the preview. You can also zoom into areas of interest. The preview also supports panning.
• Add new line properties and remove existing line properties.
• Use the colors defined for the objects in the current drawing as output colors.
• Define a default color and line thickness for those object colors used in the drawing for which you haven't defined an output color in line properties.
• Save the line property changes in the printing settings so that you can load those later on.

Other changes in line properties:
• The **Reset colors** button has been removed as it is no longer needed.

• If you have selected **Tekla Grayscale** or **Black and white** as the print color on the **Options** tab, the line property **Color on output** settings are disabled.

**Tekla Grayscale** replaces the old **Grayscale** on the **Options** tab in printing and in the drawing color mode selection in **File --> Settings**. In **Tekla Grayscale** mode, certain standard colors are shown as black, whereas the new **Grayscale** option converts all colors, standard and custom, to different shades of gray using an algorithm. In line properties, gray is shown in either grayscale mode as a percentage, for example, "Tekla Grayscale - Gray 50 %" or "Grayscale - Gray 29 %".

• If you have loaded printing settings and make some changes in the settings, the name of the settings file will be displayed in italics and will get an asterisk at the end (**MySettings*”), and the **Save** button will be enabled.

**Use colors in current drawing as output colors**

You can use object colors in the currently previewed drawing as output colors. This is a very easy way to define the output colors if you have predefined custom color palettes, and you have used the palette colors in your drawing objects.

• Ensure that the preview of the drawing is shown. If it is not shown, click **Click here to load a preview** in the preview area, which activates the button on the **Line properties** tab. Click the **button. This adds all object colors that exist in the drawing preview as new line properties to the **Line properties** tab. If a color already exists, it will not be added again. Ensure that the **Color on output** is set to **By object** for each row. The line thickness from the **Default** row is used for all rows, but you can adjust the line thickness.

**Map an object color to a custom color**

In the line properties, you can assign a custom color to an object color as the output color.

• Click a color row and select **Custom** from the **Color on output** list. In the displayed color palette dialog box, select a saved palette from the **Custom** list, click a custom color in the palette, and then click **OK**. You can also
select several rows using Ctrl or Shift, right-click and then select Output -- > Custom.

The selected color is added as the output color for the row. The line thickness is taken from the Default row, but you can adjust that. The preview shows the new color and line thickness.

Add a new line property

You can add a new line property in the list of line properties and specify the desired output for it.

- On the Line properties tab, click the + button. Select a saved palette from the Custom list, click a custom color in the palette, and click OK.

A new line property row with the selected color is added on the Line properties tab. The line thickness is taken from the Default row, but you can adjust that. If the color already exists, it will not be added.

Define the line thickness

Do one of the following:

- Enter the line thickness for each color in the Thickness box.
- Define the line thickness for several color rows:
1. Use Ctrl or Shift to select multiple rows.
2. Right-click and select Line thickness.
3. Enter the line thickness for the selected rows.

**Use default color and line thickness in printing**

- The Default color and line thickness are used for those colors in the drawing that have no definition on the Line properties tab.
- The Default line property row has the same options available for output as the other line property rows.

![Line properties tab](image)

- To use only one color and line thickness in the printout, define the desired color and line thickness for the new Default row and delete all line property rows.

**Print objects in grayscale**

- To define that a certain object color is always printed in grayscale, on the Line properties tab, click a color row and select Grayscale from the Color on output list.

![Color on output list](image)

The preview shows the drawing object in grayscale.

You can also select several rows using Ctrl or Shift, right-click and select Output --> Grayscale.
Skip objects in printing

- If you do not want to print some objects, on the Line properties tab, click a color row and select **No output** from the **Color on output** list. The drawing objects that use the object color specified on the particular line property row are not shown in the preview and not printed.

  You can also select several rows using **Ctrl** or **Shift**, right-click and select **Output --> No output**.

In the first example, all colors are printed:

![First example image]

In the second example, the drawing objects that have green or black color are not printed.

![Second example image]

Remove a line property

- On the **Line properties** tab, select one or more rows. You can use **Ctrl** or **Shift** to select multiple rows. To delete the selected rows, click **Delete** in the dialog box, or right-click and select **Delete**.
3.7 Custom colors in Template Editor

Template Editor templates now support custom colors, and Template Editor is able to use the same custom color palette files that you use for drawing objects and printing.

In Template Editor, you can:

- Change the color of a text object. To do this, double-click a text object in the template, and in the object properties, click the "..." button next to the font setting. Then click the color box and select a custom color.
• Change the color of a shape object. To do this, double-click a shape object, such as a line, and in the object properties, click the color box and select a custom color.

• Add new colors (Add) and save new custom color palettes (New).

3.8 Custom colors in drawing hatches

Custom colors in automatic hatches
You can now define custom colors for automatic drawing hatches defined in .htc schema files. The hatches defined in the .htc schema files are used when you set Type to Automatic in the Fill section in the part or shape properties.

To specify a custom color, enter the HEX value of the color in the schema file. For example, for a specific shade of green, enter 0x00DC32:
CONCRETE,,hardware_SOLID,,0x00DC32

Hatch background color None
The None option is now available for selecting in the color palette as the hatch background color. None works in the same way as before: when you select it, the drawing background color is used as the hatch background color.
3.9 Changes in advanced options related to colors

**XS_SHORTENING_SYMBOL_COLOR_RGB**

Use this new model-specific advanced option, XS_SHORTENING_SYMBOL_COLOR_RGB, to define the color of the view shortening symbol in a drawing. Leave the value empty to automatically use the same color as the part color. In addition to single color index values, you can now enter the RGB value of a specific custom RGB color. For an RGB color, enter three numeric values separated by spaces (each value in the range 0 to 255). For example, for a specific shade of green, enter 0 220 50.

This advanced option is located in the Drawing properties category of the Advanced options dialog box and it replaces the advanced option XS_SHORTENING_SYMBOL_COLOR.

**XS_SECTION_LINE_COLOR_RGB**

Use this new model-specific advanced option, XS_SECTION_LINE_COLOR_RGB, to add extra lines in different colors around automatic hatching in section views. In addition to single color index values, you can now enter the RGB value of a specific custom RGB color. For an RGB color, enter three numeric values separated by spaces (each value in the range 0 to 255). For example, for a specific shade of green, enter 0 220 50.

This advanced option is located in the Hatching category of the Advanced options dialog box and it replaces the advanced option XS_SECTION_LINE_COLOR.

**XS_POP_MARK_COLOR_RGB**

Use this new advanced option, XS_POP_MARK_COLOR_RGB, to define the color of a customized pop-mark symbol that is displayed in a drawing. The default value is 1 (white). In addition to single color index values, you can now enter the RGB value of a specific custom RGB color. For an RGB color, enter three numeric values separated by spaces (each value in the range 0 to 255). For example, for a specific shade of green, enter 0 220 50.

This advanced option is located in the Drawing properties category of the Advanced options dialog box and it replaces the advanced option XS_POP_MARK_COLOR.

**XS_DRAWING_CHANGE_HIGHLIGHT_COLOR**

You can use the advanced option XS_DRAWING_CHANGE_HIGHLIGHT_COLOR to change the highlight color of the automatic change symbols. In addition to
single color index values, you can now enter the RGB value of a specific custom RGB color. For an RGB color, enter three numeric values separated by spaces (each value in the range 0 to 255). For example, for a specific shade of green, enter 0 220 50.

**Advanced options defining Special hatch color removed**

The following advanced options that were used for defining the Special hatch color for printing and export have been removed from Tekla Structures 2024:

- XS_HATCH_SPECIAL_COLOR_ACI
- XS_HATCH_SPECIAL_COLOR_R
- XS_HATCH_SPECIAL_COLOR_G
- XS_HATCH_SPECIAL_COLOR_B

You can now define custom RGB colors and use those in hatches instead. Models created with Tekla Structures versions older than 2024 containing values for the removed advanced options are still supported.

### 3.10 Other changes in colors

The name of the standard yellow color has been changed to **Yellow/Olive** to better explain that yellow is shown differently based on the drawing background color (black or white). Also the icons representing the **Yellow/Olive** color in drawings and printing have been changed accordingly.

![Yellow/Olive color](image)

### 3.11 Limitations in drawing colors

**Limitations in using custom colors**

There are some limitations in the usage of custom colors. The custom colors are not supported:
• When defining drawing frame and fold mark colors in **Drawing layout editor**

![Drawing size settings](image)

- When you create cut lines to visualize the lines that are partially outside the view frame
- When you create pattern lines in **Pattern line editor**
- In Snapshot overlays
• In the property pane and in the property dialog boxes for the drawing objects, the custom color names are not shown, instead the RGB codes are shown.

**TIP** You can use standard colors for the unsupported objects, and then select the desired custom colors for the output in printing.

**Pre-existing drawing color related limitations**

There are also some pre-existing drawing color related limitations. There are some color and line properties in parts and neighbor parts that you cannot control in the part or neighbor part properties:

• You cannot control the part and neighbor part section line color. You can only control the section line color at the model level for all drawings using `XS_SECTION_LINE_COLOR_RGB`.

• You cannot control the line color and type for hidden lines, own hidden lines, center lines, or hidden lines. You can only control the center lines line type at the model level for all drawings using `XS_CENTER_LINE_TYPE`.

• You cannot control the shortening symbol line color and line type. You can only control these properties at the model level for all drawings using `XS_SHORTENING_SYMBOL_COLOR_RGB` and `XS_SHORTENING_SYMBOL_WITH_ZIGZAG`.

• You cannot specify transparency levels for lines or fills. All objects are opaque.
New font height metric option for printing and exporting drawings: CAP height

You can now use CAP height as the font height metric in Tekla Structures drawings and have more control over the font height in drawing-related content like printing and exports.

Traditionally, the height of text in Tekla Structures drawings has been based on em (point size) font height metric only. However, some projects require the height of the text to be determined using another industry standard, CAP font height. CAP height represents the height of a capital letter more accurately than em height.

(1) CAP height
With the new advanced option `XS_DRAWINGS_USE_CAP_HEIGHT_FOR_FONT_HEIGHT` you can control the font height in drawings. This model-specific advanced option is located in the **Drawing properties** category in the **Advanced options** dialog box.

- When you set this advanced option to **TRUE**, CAP height is used in the drawing export (DGN, DWG, and DXF) and printing (paper, plot files, PDF), and the font height is the same as the height of the capital letters of a specific font. When you use CAP height, the font height set in the Tekla Structures drawing is the same when you open the drawing in Autodesk AutoCAD or Bentley MicroStation, or print the drawing to paper or to a PDF.

- When you set this advanced option to **FALSE**, the em font height is used. When you use em height, and export the drawing from Tekla Structures to a DWG file, for example, the font height is converted from one unit to another (from em to CAP), and the result is many times an incorrect font height.

- The default value is **FALSE**, and you may need to change the value to **TRUE** in your environment or for some of your projects.

The image below illustrates the difference in the font height in an exported DWG file when the advanced option is set to **TRUE** (CAP height is used) or **FALSE** (em height is used):
Font height in drawing templates

The font metric change is not automatically applied to existing templates. Texts in drawings created by the drawing templates from Template Editor are not directly affected by the XS_DRAWINGS_USE_CAP_HEIGHT_FOR_FONT_HEIGHT advanced option. The reason for this is that the change in the font height might cause overlapping in the template fields.

• If you want to use CAP height in a specific drawing template, you need to select the **Use font CAP height** option in the page properties of the particular template and then adjust the template content as necessary to correct any overlapping fields.

• When you create a new drawing template, the preselection of the **Use font CAP height** option depends on how you have started Template Editor:
  • If you have started Template Editor from within Tekla Structures from the **File** menu or when editing a drawing layout, Template Editor follows the XS_DRAWINGS_USE_CAP_HEIGHT_FOR_FONT_HEIGHT setting.
  • If you have started Template Editor from outside Tekla Structures from the Microsoft Windows **Start** menu, the option is controlled by
Template Editor preferences, and if you have selected the **Use font CAP height for new graphical templates** check box:

![Template Editor Preferences](image)

**NOTE** The template file version has been increased to enable the new CAP height unit, and older versions of Tekla Structures will not be able to use the newly created or edited templates.

**NOTE** For the existing, old version templates, the **Use font CAP height** option is not selected by default. To use CAP height in an old template, open the template for editing, select the **Use font CAP height** check box in the page properties, and save the template.
New DGN export option for drawings

Tekla Structures 2024 provides an efficient, direct export of drawings to the Microstation 2D DGN v8 format, which meets the requirements of bridge and other civil stakeholders.

The direct export to DGN helps to avoid the risk of data loss associated with the multi-step conversion from drawing to DWG and further to DGN.

The DGN is incorporated in the existing drawing export, and the drawing export dialog box now contains a new option to export 2D drawings in the DGN v8 format in addition to the existing DWG and DXF formats. The export is set up in a similar way as the existing drawing DWG/DXF export, however the template files are separate and some labels use format-specific terminology.

Improvements and changes in the drawing export:

• The dialog box has a new title to include the DGN format: **Export drawings as DWG/DXF/DGN.**

• New file type **DGN (V8)** has been added.

• New tooltips guide the user through the setup.

• The selected export file type defines some of the labels, and the tooltips are adjusted respectively.
• In the DGN files, drawing blocks are called shared cells. In the new DGN export, the **Ungroup objects in shared cells** option exports all graphical objects as individual objects instead of shared cells.

• You can use a DGN seed file and configure the rules for mapping object elements to specific DGN levels.
• In the DGN export, the rules are configured on the **Level rules** tab. The **Target levels from DGN** option allows you to browse for a DGN template.

![DGN Export Options](image)

• You can also define whether the linework (color, line style, line weight) is taken from Tekla Structures settings or from the DGN template.

• In the DGN export, to draw drawing objects correctly in the coordinate space, select the check box in the **Coordinate space** column.

• The DGN file format is now included in **Document manager** in the common and default environments. If **Document manager** does not show the DGN files, you can add the file type in the **DocumentManagerFileDocumentSettings.txt** file located in your model, project, or firm folder.
• The **BIM Publisher** extension now supports DGN files.
New way to handle empty marks and associative notes

The way Tekla Structures handles manually added empty marks and associative notes has been improved.

With the new advanced option, XS_SHOW_EMPTY_MARKS, the handling of the empty marks and notes is easier and faster.

If you set `XS_SHOW_EMPTY_MARKS` to `TRUE`:

- Tekla Structures creates the marks or notes that have no content with the "Content not defined" text and shows the following status bar message:

  "Marks without content have been created. Use XS_SHOW_EMPTY_MARKS to control this."

- You can then double-click the mark or note and add the content in the property pane.

If you set `XS_SHOW_EMPTY_MARKS` to `FALSE`:

- Tekla Structures creates the marks that have no content and selects these empty marks in the drawing. The following status bar message will be shown when these invisible marks without content have been created:

  "Invisible marks without content have been created – Add elements to mark content and click Modify."

- If marks of only one mark type without content have been created, the property pane opens immediately indicating in the visual editor that the content is not defined, and you can add the desired content.
• If marks of two or more mark types without content have been created:
  • Property pane opens, and there is an exclamation mark next to the object type list arrow button indicating that the list contains mark types with empty marks.
  • The property pane keeps all marks with empty content visible in the object type list so that you can select each mark type and add mark content if desired. You can also leave the marks with no content, or delete them.

This user-specific advanced option is located in the **Drawing properties** category in the **Advanced options** dialog box.

This improvement was already introduced in **Tekla Structures 2023 SP5**.
Improvements in drawing dimensions

Tekla Structures 2024 introduces new rounding options in dimension properties, improved bolt group and array dimensioning, changes in rebar pull-out dimensions, and some new options to be used in Dimensioning rule properties.

7.1 New rounding options in dimension properties

The dimension properties in automatic and manual dimensioning now have three new rounding options: 2.50, 5.00, and 10.00. These new options work only when the unit is mm.

<table>
<thead>
<tr>
<th>Units</th>
<th>mm</th>
</tr>
</thead>
<tbody>
<tr>
<td>Precision</td>
<td>0.00</td>
</tr>
<tr>
<td>Format</td>
<td>0.00</td>
</tr>
<tr>
<td>Combine equal dimensions</td>
<td>0.33</td>
</tr>
<tr>
<td>Exaggeration</td>
<td>0.25</td>
</tr>
<tr>
<td>Exaggerate short dimensions</td>
<td>1/8</td>
</tr>
<tr>
<td>Direction</td>
<td>1/16</td>
</tr>
<tr>
<td>Origin</td>
<td>1/32</td>
</tr>
<tr>
<td>Position</td>
<td>1/10</td>
</tr>
<tr>
<td></td>
<td>1/100</td>
</tr>
<tr>
<td></td>
<td>1/1000</td>
</tr>
<tr>
<td>2.50</td>
<td>5.00</td>
</tr>
<tr>
<td>10.00</td>
<td>(1)</td>
</tr>
</tbody>
</table>
Improvements in drawing dimensions

Improvements in view-level dimensioning
7.2 Improvements in view-level dimensioning

New option None to skip creation of dimension points

The dimensioning rule setting Measure from has a new option None, which you can use when you do not want to create any dimension points to the surrounding geometry.

New option Midpoint to start measuring from center point

The dimensioning rule setting Measure from has a new option Midpoint, which uses the center point of an object as the origin point for the dimensions. This option is useful for dimensioning bolt holes in a base plate, for example.
Midpoint is available for the Measure from options Main part, Current part and Part name in the Filter, Secondary parts, Holes, Recesses, and Neighbor parts dimensioning methods.

New option to measure only outside perimeter
The Edge shape dimensioning method has a new option Visible faces, parts merged, which dimensions only the outside perimeter of an assembly. Previously, there were two options, All faces and Visible faces, and now the latter one has been renamed to Visible faces, parts separated to clarify the difference to the new option Visible faces, parts merged. The new option is typically needed for trusses, when only the outside perimeter of the truss is dimensioned.

Example of Visible faces, parts merged:

![Example of Visible faces, parts merged](image1)

Example of Visible faces, parts separated:

![Example of Visible faces, parts separated](image2)

Improved bolt group and array dimensioning
Bolt group and array dimensioning with the dimensioning type Filter has been improved so that each individual bolt is dimensioned with all dimension point
location options (left, center, right, both). Previously, this was only working for bolt arrays, when the dimension point location was set to center.

The **Only objects on the selected sides** setting now works for bolt groups.

![Diagram](image)

### 7.3 Dimensions in rebar mark pull-out pictures

Previously, rebar mark pull-out pictures in a drawing section view only showed dimensions for bars in a tapered rebar group that were actually inside the view boundary. Now, dimensions are shown for all bars in the group, regardless of whether some of the bars are outside the view boundary.
8 Other improvements in drawings

Tekla Structures 2024 introduces changes and important improvements in fabrication drawings, fonts, printing settings, Drawing content manager, length attributes in rebar marks, rebar pull-out pictures and marking, rebar group marking, in handling drawing versions, and in Rebar mesh view creator.

8.1 Keeping needed drawing versions

As drawing versions might be defined to be automatically removed with the advanced option XS_DELETE_UNNECESSARY_DG_FILES, you might want to protect some versions from the removal. The Drawing versions feature introduces a new option to mark versions as Always necessary, which means
that the version you select will be protected from the automatic removal of the old drawing versions.

This improvement was already introduced in Tekla Structures 2023 SP1.
8.2 Fabrication drawings - use copying and pasting in model path

When you want to select another model as the source for templates, you can now use copying and pasting in the folder path box in the Creation review dialog box.

8.3 Arial is the new default font in drawings

The default font setting for texts, value fields, and marks in drawings has been changed from Arial Narrow to Arial in the Common and Default environments. The reason for replacing the Arial Narrow font is that it is not always delivered in the Windows installation and may be missing from the computer.

8.4 Changes in handling printing settings

Handling the printing settings has been improved, and you can now see more clearly if the settings have been changed or not.

- Now when you open the Print Drawings dialog box, and load some printing settings, the Save button remains disabled.
- Once you make some changes in the printing settings, the name of the settings file will be displayed in italics and will have an asterisk at the end. The Save button will be enabled once you have changed the settings.
Tekla Structures 2024 also introduces custom RGB colors and improvements in line property handling in printing. For more information, see New custom colors in drawings and improvements in line properties (page 12).

8.5 New categories in Drawing content manager

Drawing content manager now has two new building object categories: Sub-assemblies and Reference objects.

You can quickly and easily, for example:

- Add marks to or remove marks from sub-assemblies and reference objects.
- Check how many marks sub-assemblies and reference objects have in one view or in the entire drawing.
- Check the sub-assembly hierarchy level.

You can now also control how sub-assembly parts are shown in Drawing content manager by using the new Show sub-assembly secondary parts option on the Options menu.

Show sub-assembly secondary parts is by default selected so that Drawing content manager lists in the Parts category all the parts that belong to the selected assemblies and sub-assemblies. In addition, the assembly main parts are listed in the Assemblies category and the sub-assembly main parts in the Sub-assemblies category.

If you do not wish to show sub-assembly parts in the Parts category, click Show sub-assembly secondary parts. Now only the Sub-assemblies category will list the sub-assembly parts.

8.6 Length attributes in rebar marks and tags

The unit setting for CC, CC_CROSS, CC_DIAMETER_CROSS, CC_DIAMETER_LONG, CC_EXACT, CC_EXACT_CROSS, CC_EXACT_LONG and CC_LONG stopped working when a fix was made to get them working in filtering. Our investigations confirmed that these two requirements are contradicting and they cannot work simultaneously. Based on the customer
feedback, we have now decided to reverse the previous fix, which means that now the above mentioned attributes no longer work in filtering by default.

You can control this functionality in contentattributes_global.lst. By default, the Unit type is now set to Length for these attributes, which enables the unit settings in drawings but the filtering does not work. If you leave the unit type empty, the filtering works but the unit settings do not.

Here is an example line from contentattributes_global.lst of a situation where the unit settings work in drawings:

CC_EXACT CHARACTER LEFT TRUE 20 0 Length mm

8.7 Rebar pull-out pictures and marking - add custom properties in marks

You can now add custom properties in rebar marks. To do this, in mark content settings on the Mark 1 or Mark 2 tab, select Template attribute from the Available elements list and enter the name of the custom property, for example, CUSTOM.REBAR_NUMBER.

8.8 Rebar group marking - speed improvements

Rebar group marking speed has been improved by changing the tool update behavior in the drawing opening. Now the tool is updated only when the related objects in the model have changed. Previously, all instances of the tool were always updated in the drawing opening.

8.9 Improvements in Rebar mesh view creator

- Bent rebar assemblies and rebar sets are now supported.
- The name of the rebar mesh view now comes from the CATALOG_NAME template attribute.
- A new option, Bent mesh rotation, has been added for rotating bent meshes. The options are Default, 90, 180, and 270. If you select Default, meshes are always oriented so that the bent rebars are on the horizontal axis.
Tekla Structures 2024 provides a property pane for all drawing objects, introduces the copy to clipboard functionality, allows typing in user-defined attributes in the property pane editor for annotations, and contains important improvements in adding frames around annotation objects and in creating section views and detail views.

9.1 **New object types in drawing property pane**

The drawing property pane was introduced in Tekla Structures 2023 for many but not all of the drawing objects. In Tekla Structures 2024, all drawing object property panes are in place, providing a consistent, easier to learn and use interface.

The property pane is now available for the following drawing object types replacing the previously used object-level property dialog boxes:
• Revision mark
• Symbol
• Rich text
• Edge chamfer
• DWG/DXF file
• Image file
• Drawing link
• Hyperlink

To modify the drawing object properties, click the object in a drawing, enter or select the desired values, and click **Modify**. If the property pane is not open, double-click the object.

To set the property values to be used in the object creation, open the object type list from the arrow button on the left side of the property pane, select an object, modify the values, and then create objects of the selected type.
9.2 **Copy to clipboard - new way to copy object properties in property pane**

The new **Copy to clipboard** command is available in the property pane both in modeling and in drawing mode. **Copy to clipboard** copies all property values of a selected object. It is especially useful in drawing editing when you need to change the representation properties in many drawings for different object types, such as parts or different types of marks. **Copy to clipboard** allows you to copy drawing object property values and paste them to same type of drawing objects located in the current or in any other drawing.

You can use keyboard shortcuts to speed up your work, and copy and paste the properties from one object to another even without opening the property pane. The **Copy to clipboard** command has a default shortcut **Shift+C**, and the **Paste** command has a default shortcut **Shift+V**.

For more information about this new feature, see [Copy to clipboard - new way to copy object properties in property pane (page 62)](#).

9.3 **Improved property panes for creating detail views and section views**

When creating detail views, section views, and curved section views, you can now easily define both the mark label properties and the view properties in the **Detail mark with view** and **Section mark with view** property panes.
These property panes now have separate tabs for controlling the mark label properties and view properties.

Drawing property pane improvements

Improved property panes for creating detail views and section views
The section and detail view improvements were already introduced in Tekla Structures 2023 SP5.

9.4 Possibility to type in user-defined attributes

In the visual editor for annotation objects, such as notes, marks, and dimensions, you can now add any user-defined attributes in the annotation by typing them in the element search box.

![Element search box](image)

The user-defined attribute handling was improved already in Tekla Structures 2023 SP4.
9.5 **Improved frames in drawing annotation objects**

We have improved how the frame options for the various annotation objects in the drawing property pane work in different situations, and also changed the how the frame options are called.
The frame improvements were already introduced in Tekla Structures 2023 SP3.
More efficient way copy object properties in the property pane: Copy to clipboard

In Tekla Structures 2024 there is a new, more efficient way to copy properties between objects: **Copy to clipboard**. The new **Copy to clipboard** command can be used in addition to the current **Copy to other object** command.

**Copy to clipboard** copies all properties of the selected object to the Tekla Structures clipboard. You can then paste the properties to the selected objects. The **Copy to clipboard** command is available in the property pane both in modeling and in drawing mode. Note that **Copy to clipboard** works only in Tekla Structures, and it is not the same as the Windows clipboard.

This new method to copy object properties is useful especially if you need to edit drawings. You can select objects in the current or in any other drawing, and the **Copy to clipboard** command lets you to paste properties to objects that are located in the same drawing or even in other drawings. This is useful especially if you need to modify different types of objects in a sequential work flow in multiple drawings, such as part marks, reinforcement objects, or dimensions.

To copy object properties using **Copy to clipboard**:

1. Select the object in a model or in a drawing that you want to copy the properties from.

2. Click the **Copy to clipboard** button at the bottom of the property pane.

   The properties of the selected object type are saved to the clipboard.

3. Select the objects to which you want to copy the properties.

   The objects need to be **of the same object type** as the one from which the properties were copied from.
4. Click the **Paste** button at the bottom of the property pane.

The properties in the property pane change accordingly and the selected objects are modified.

The **Paste** button is visible only if there is something to paste from the clipboard to the object type in question.

**Other things to consider**

• Tekla Structures saves the copied properties of every object type to the clipboard, independently of each other. You can later paste the properties to objects that are of the corresponding object type.

• If you select multiple objects when you are about to paste the copied properties, use the **Object type list** to select the object type to which to paste the properties from the clipboard. The **Paste** button is visible only if there is something to paste from the clipboard to the object type in question.

• You cannot paste properties to objects which are of different type than the object from where the properties were copied from.

• The properties will stay on the clipboard until you copy new properties. The clipboard is cleared if you restart Tekla Structures.

• The **Copy to clipboard** command copies all properties of the selected object to the clipboard. You cannot select only certain properties to be copied to the clipboard.

• The **Copy to clipboard** and **Paste** commands allow you create objects while the copying or pasting is active. For example, you can start to create an object, click **Copy to clipboard**, the properties are saved to clipboard and you can continue creating the object.

### 10.1 Keyboard shortcuts for Copy to clipboard and Paste commands

Use keyboard shortcuts to speed up your work. With keyboard shortcuts you can, for example, copy and paste the properties from one object to another even without opening the property pane.

The **Copy to clipboard** command has a default shortcut **Shift+C**, and the **Paste** command has a default shortcut **Shift+V**. If needed, you can change the default shortcuts in **File --> Settings --> Keyboard shortcuts**.
10.2 Control the visibility of the Copy to clipboard and Copy to other object buttons in the property pane

If you do not need both of the copying methods, Copy to other object and Copy to clipboard, you can make the property pane less cluttered and hide the option that is not needed. You can control the visibility of the buttons separately in modeling mode and in drawing mode.

Use the Property pane settings button to select which method is visible in the property pane.

1. Click the Property pane settings button to open a drop-down menu.

   The options Copy properties to object and Copy properties to clipboard control the visibility of the corresponding buttons in the property pane.

2. Ensure that the option you wish to use is selected.

   The option that is not selected is hidden in the property pane.

The settings are saved to the PropertyPaneSettings.xml or to the PropertyPaneDrawingSettings.xml file. The files are located in the ..\Users\<user>\AppData\Local\Trimble\Tekla Structures \<version>\UI\PropertyPane\ folder.

The Copy properties to object and Copy properties to clipboard options in the file are:

- ShowCopyProperties: True when Copy properties to object is selected
- ShowCopyToClipboard: True when Copy properties to clipboard is selected

More efficient way copy object properties in the property pane: Copy to clipboard

Control the visibility of the Copy to clipboard and Copy to other object buttons in the property pane
11 New interactive model view rotation

The symbol for local coordinate system in the model view has been replaced with a new, interactive view rotation symbol, and thus making it easier to quickly rotate the model from 3D view to a desired 2D plane. The new view rotation symbol is similar to the one in Trimble Connect.

The new view rotation symbol is at the lower right corner of the model view:

You can now easily rotate the model view from 3D to a new 2D plane by clicking the navigation control axes in the symbol. Previously, you had to create the default views of a part or use the View angle commands on the contextual toolbar for a desired view.

When you click the navigation control axes in the symbol, the model view rotates around the current rotation point and the level of the zoom stays the same. Also the movement to the selected position is animated when the rotation is changed. To return to the 3D view, rotate the model using your mouse.

If you rotate the view for example using the Rotate with mouse command, the new navigation control symbol shows the rotation respectively.
New interactive model view rotation
Tekla Structures 2024 has a new snapping option: snap to parallel points. Also, you can now snap to object faces in a 3D model view.

12.1 Snap to parallel points

Tekla Structures 2024 has a new snapping option: **Snap to parallel points**. You can now snap to points that are parallel to grid lines, part reference lines, and the edge lines of existing objects or reference objects. Snap to parallel points works both in modeling mode and in drawing mode.

Use the **Snap to parallel points** switch, for example, when you need to:

- model new parts or structures that are parallel to an existing structure or parallel to a grid line, such as strip footings or walls
- model parts when you know the distance between the parallel reference part and the part to be created
- cut polygonal shapes that are parallel to edge lines of irregular shapes

To snap to parallel points:

1. Activate the **Snap to parallel points**
   
   snap switch on the **Snapping** toolbar.

2. Run a command that requires you to pick points.
   
   For example, start creating a beam.
3. Pick the start point in the model.

Alternatively, you can pick a temporary reference point by holding down the Ctrl key and then pick a point that is used as a reference point.

If you pick a point on a line, Tekla Structures gives an offset value of 500 mm in orthogonal direction. You can enter another numeric distance, or move the mouse to define the distance of the parallel point.

4. Place the mouse pointer on top of a line or an edge that you want to use as basis for the parallel snap, and using the mouse pointer follow the line or the edge to the desired direction. Keep the mouse pointer close to the line or the edge.

Tekla Structures shows the parallel snap symbol and a green, dashed line that indicates the dependency between the picked point and the parallel point.

If you move the mouse pointer further away in the direction of the line or the edge, the parallel snap follows the extension of the line or the edge.
5. Pick the rest of the points, or enter a distance by using the keyboard and press Enter.

Alternatively, if you had previously picked a temporary reference point, pick the start point.

Note that the new Snap to parallel points snap switch has lower snap priority than Snap to end points, Snap to mid points, Snap to perpendicular points and Snap to intersection points snap switches.

You can also use the Snap to parallel points - override switch to temporarily override the other snap switch settings.

12.2 Snap to perpendicular and intersection points on object faces

You can now snap to object faces in 3D model view when you have the Snap to perpendicular points or the Snap to intersection points snap switch active.

Note that you can only snap to object faces when the rendering of parts is set to Parts rendered/Components rendered/References rendered.
When the **Snap to perpendicular points** snap switch is active, you can snap perpendicularly to a point on the object face. Previously you could snap perpendicularly only to a line.

If the **Snap to perpendicular points** snap switch is the only active snap switch, Tekla Structures finds the snap point even when the mouse pointer is far away from the correct location. If other snap switches are on, then Tekla Structures finds the perpendicular snap point only when the mouse pointer is placed close to the correct location.

When you start to pick points, and the first picked point is in front of the object face and within the object face boundaries, the perpendicular point will be at the object face. If the first picked point is outside the object face...
boundaries, the perpendicular point is created perpendicular to the object face plane and it is not at the object face.

- When the **Snap to intersection points** snap switch is active, you can snap to the intersection of an object face and a point on a part edge line, point on a construction line, or point on a grid line.
Renewed interactive bolt creation with preview

Tekla Structures 2024 introduces two new options and a preview in the bolt creation command. It is now easy to create bolts correctly at once, with one click in the model. You can visually check that the bolts will be created in the desired location and have the bolt head at the appropriate end.

When you start the renewed Bolt command from the Steel ribbon tab, the contextual toolbar opens with three options to place bolts and holes, or studs:

With the two new options and where you use a part face, the edge of the part face that is nearest to the mouse pointer is selected as the basis for the preview. The bolt group direction will be perpendicular to this edge.

To create bolts using the new options:

- Click **By face**, and then pick a location on a part face.
  
  If you want to temporarily lock the edge direction, hold down **Alt** while you pick.
  
  With this option, Tekla Structures uses the **Cut length** value in the Bolt properties to automatically select the parts to be connected.
  
  The part with the largest volume will be the main part, and the secondary parts will be in order that they are found.

- Click **By parts and face**, and then select the main part and the secondary parts, click the middle mouse button, and pick a location on a part face.
If you want to temporarily lock the edge direction, hold down **Alt** while you pick.

With this option, Tekla Structures calculates the bolt cut length based on the parts that you selected, and corrects the **Cut length** value in the **Bolt** properties.

To create bolts in the same way as in the previous versions, but with the help of a preview:

- Click **By parts and points**, and then select the main part and the secondary parts, click the middle mouse button, and pick two points to define the bolt group origin and x direction.

Note that when you pick locations, you can use various snapping methods, such as numeric snapping, or you can create temporary reference points by holding down **Ctrl**.

To change the bolt direction, you can use the contextual toolbar either while you are placing the bolts, or after you have created and selected the bolts.

Clicking **Flip bolt direction** changes the direction of the bolts by 180°, but maintains the other bolt properties, such as the order of special holes and the hole locations.

In the preview that is shown before the bolts are created, bolt heads are shown with crosses:

If you want to snap to part center lines when you are placing the bolts, click **Snap to center lines** on the contextual toolbar. Then select whether you want to show the center lines for profiles, such as beams and columns, or for plates, or for both.

When you are placing the bolts, you can adjust whether dimensions are shown in the preview. On the contextual toolbar, click **Dimensions**, and then click **Internal dimensions** to show or hide the dimensions between the bolts in the group.
Improved in-app instructions for self-sufficient learning experience

Tekla Structures has now more in-app help and guidance for an easy, self-sufficient learning experience.

- **Tekla Structures - Setup** and **Tekla Structures - Start** windows now have tooltips. When you rest the mouse pointer on the icon, the related tooltip is shown. The tooltips provide more information about the options on the dialog boxes.

- On the **Tekla Structures - Start** window, the **Learn the product** section now has links to the **First steps** course, a link to **Trimble Learn**, and to **Tekla User Assistance**.

- All side pane windows now have a drop down menu with options to float or attach the side pane window. Click the button in the upper right corner of a side pane window and select a suitable option.

The options are **Attach to left side**, **Attach to right side** or **Attach to bottom**, depending on the current side pane window location.

- **Instructor** side pane window now has new navigation options for easier access of all needed content.

New **Home**, **Back**, and **Forward** buttons have been added at the top of the **Instructor** side pane window. Clicking the **Home** button will bring you to the **Instructor** start page where you can find useful links for further
information. Use the Back and Forward buttons to see content on the next or the previous pages.

In addition, the Select language option and the Add help file option have now been moved to the top of the Instructor side pane window.

- You now have easy access to learning resources and support material. Now, in modeling mode and in drawing mode, the top right corner of the screen shows a blue help icon.

When you click the icon, a menu opens with links to learning resources and support material.

These improvements were already introduced in Tekla Structures 2023 SP 4.
15 Other modeling improvements

15.1 Changes in saving macros

The macros you create are now saved under the model folder, in the \macros\drawings or \macros\modeling folder depending on the mode (drawing or modeling) you are using while creating the macros. Tekla Structures creates these folders automatically when you create macros.

Previously, you selected the folder location Global or Local when creating your own macros.

To record a macro or to create a macro file, go to the Applications & components catalog, click Access advanced features, and select either New macro or Record macro.
The `\macros` folders under the model folder are shared in Tekla Model Sharing.

### 15.2 Change in controlling pour unit visibility in Organizer

Tekla Structures 2022 introduced the **Pour units enabled** setting in **Organizer**, enabling you to control whether pour units or cast-in-place cast units are used as the highest cast-in-place hierarchy level in **Organizer**. The **Pour units enabled** setting is located on the **Synchronization** tab in **Organizer Settings**.

**Tekla Structures 2023 SP1** introduced a change to this feature. From Tekla Structures 2023 SP1 onwards, to use the **Pour units enabled** setting, you need to set the `XS_ENABLE_POUR_MANAGEMENT` advanced option to **TRUE**. Note that if the `XS_ENABLE_POUR_MANAGEMENT` advanced option is set to **FALSE**, the **Pour units enabled** setting is not shown in **Organizer**, and you cannot use pour units as the highest cast-in-place hierarchy level in **Organizer**.

Previously, the **Pour units enabled** setting was always available in **Organizer Settings**, regardless of the advanced option value.
15.3 Updates in the Compare commands

When you compare parts, assemblies, or cast units and use the Compare parts or Compare assemblies command under Edit --> Compare or on the context menu, Tekla Structures now shows a report with more details about the comparison. For example:

![Image of report]

If you select rows in the report, Tekla Structures highlights the corresponding objects in the model, and you can investigate the objects further. For example, you can select sub-assemblies in the previously compared assemblies and use the Compare assemblies command again to compare the sub-assemblies.

If necessary, you can customize the comparison report template to suit your needs. When Tekla Structures is installed in the ..\Program Files folder, the template is by default available in the folder ..\ProgramData\Trimble\Tekla Structures\<version>\Environments\common\system\ . Copy the TS_Report_Assembly_Comparison.rpt template to your project or firm folder and then modify the copied template as needed.

Previously, the comparison results were only shown on the status bar.

15.4 Changes in non-linear model object solids

The way how non-linear model objects, such as lofted slabs, are generated has been improved in Tekla Structures 2024. After this update, if you open a model that was created in a previous version of Tekla Structures, the number of faces in a solid object may change. If there are surface objects or rebar sets with leg surfaces created on such solid objects, the changed number of faces may cause gaps to appear between the surface objects or leg surfaces. Because it is technically challenging to automatically fix these gaps, they need to be fixed manually and you may need to create new surface objects or leg surfaces to fill the gaps.
16 Reinforcement improvements

Tekla Structures 2024 introduces a renewed method for the generation of bars in rebar sets, and several other updates in reinforcement features.

16.1 Renewed bar generation method for rebar sets

In Tekla Structures 2024, we have completely renewed the way how rebar set bars are generated for non-linear geometries. With the new method, the bars follow the underlying concrete geometry much better and bars that are not valid are less likely to occur.

The previous bar generation method did not always work with complex geometries and it might produce invalid bars or incorrect bar geometries.
To address these issues, we now also introduce a user control for the generation accuracy, to ensure valid bar geometry generation. The new **Smoothing factor** user-defined attribute (UDA) is available for rebar sets on the **Rebar set** UDA tab. This setting is useful when leg surfaces in complex geometry parts do not produce the desired bar geometry. There might be too short consecutive, zigzagging bar segments, or in some cases bars might not follow the concrete surface closely enough.

**Smoothing factor** is a percentage of the overall leg length, so a value between 0 and 100. If a leg segment is shorter than this percentage of the overall leg length, it is eliminated. The default value is 0.1. To eliminate the leg segments causing a zigzag effect, increase the value. To make the bars follow the concrete surface more closely, decrease the value.

**Smoothing factor not adjusted**

**Smoothing factor adjusted**

![Smoothing factor not adjusted](image1)

![Smoothing factor adjusted](image2)

Smoothing factor = 5
The Extra point shortening attribute, on the Shape recognition tab of the rebar UDA dialog box, is now also used in rebar set bar generation to determine whether two bar legs are sufficiently collinear, for a given Extra point shortening tolerance, that they can be considered as one. If no Extra point shortening value is specified, the value is given by the advanced option XS_REBAR_RECOGNITION_EXTRA_POINT_SHORTENING, which has a default value of 0.3. Typical Extra point shortening values are between 0.3 and 2.56.

16.2 Updates in rebar geometry handling in numbering

The advanced option XS_REBAR_GEOMETRY_TYPE_IN_NUMBERING was introduced in Tekla Structures 2023 SP1. You can use it to specify how the geometry of reinforcing bars is taken into account in numbering and which type of bar geometry is used when bars are compared with each other. Now, in Tekla Structures 2024, the default value of this advanced option has been changed from POLYLINE to FABRICATION.

Using the FABRICATION option means that, in addition to converting segmented arcs in reinforcing bars to true arcs (= the RATIONALIZED option), Tekla Structures uses Maximum curve radius requiring bending to treat certain arcs as straight legs in numbering. Also bars that have the Recognize as straight bar UDA set to Yes are treated as straight bars in numbering.

For example, top face bars of a sloping drainage slab are often small diameter bars that can be treated and delivered as straight bars.
The selected geometry type, for example FABRICATION, is also used when cast units are numbered and their reinforcing bars are compared.

16.3 Update in automatic attachment of rebar set bars to concrete parts

The algorithm for calculating the parent part of bars in a rebar set has been modified because previously in certain cases the wrong part was chosen. The change is in the definition of a vertical bar.

A bar is now considered horizontal if its overall horizontal extent $H$ is longer than or equal to its overall vertical extent $V$ multiplied by the default factor of 2. Otherwise the bar is considered vertical.

$$(1) = \text{horizontal bar}, \quad (2) = \text{vertical bar}$$

In general, a bar in a rebar set is considered horizontal if:

$$H \geq XS\_REBAR\_VERTICAL\_FACTOR \times V$$

For more information about adjusting the default factor, see XS\_REBAR\_VERTICAL\_FACTOR in Tekla User Assistance and in Changes in advanced options (page 138).

16.4 User-defined attributes of bar ends

The reinforcing bar end specific UDAs, which are used with couplers and end anchors, are now controlled with the new advanced option XS\_REBAR\_END\_SPECIFIC\_UDA\_METHOD. If you use the default value START\_AND\_END, start leg and end leg UDAs are created, for example,
If you set the advanced option to SHORT_AND_LONG, short leg and long leg UDAs are created, for example, THREADED_LENGTH_L.

**NOTE**
- When you open a model created with a previous version of Tekla Structures, remember to check and, if needed, change the value of this advanced option.
- This advanced option overrides the suffixes defined in the RebarCoupler.Udas.dat file. Regardless of which suffixes are defined in the file, they will be replaced based on the value of this advanced option.

See also Changes in advanced options (page 138) and Administrator’s release notes: Reinforcement improvements (page 154).

### 16.5 Improvements for spiral reinforcing bars

- The length of spiral bars is now calculated and reported correctly.
- The number of rounds and the length of spiral bars are now displayed correctly in the Inquire object dialog box.
- The rounding of Number of rounds is done accurately for spiral bars.
- The new Number of rounds box is now displayed for spiral bars in the property pane instead of the Number of reinforcing bars box.
  
  With Number of rounds, the Exclude options are no longer available for spiral bars.
  
- The new template attribute ROUNDS can be used to show the number of rounds for a spiral bar wherever the number of rounds is needed, for example, in report templates and in reinforcement marks in drawings. The ROUNDS attribute shows a decimal value, since the number of rounds is not always a whole number. The same value is also shown in the Inquire object dialog box.

### 16.6 Other reinforcement updates

- The maximum number of bars in a reinforcing bar group or in a reinforcement mesh has been increased from 1000 to 10000.
• Previously, in some cases, a rebar set splitter might change the side of lapping or cranking in the middle of a splice.

This happened, for example, if the splitter was at the edge of a round hole in a vertical face. This has now been improved, and the lapping or cranking side is consistent.

• Rebar shape manager now uses the new bar geometry type FABRICATION. Previously it used the non-simplified polyline bar geometry, which might have led to inconsistencies between Rebar shape manager and reporting.

• The RebarShapeRules.xml file has been updated, and the rebar shapes with arcs in them, such as shapes 34 and 49, are now excluded from the rebar shape catalog and rebar shape placing tool.

• Rebar shape recognition was improved in Tekla Structures 2023 SP4. Rebar shape recognition now also finds arcs from reinforcing bars that have irregular point geometry. Previously, rebar shape recognition only tried to find arc geometry if the bar geometry points were at a regular distance from each other with a regular angle between them.
- Spacing properties are now available for circular and curved rebar groups in the **Custom component browser**, and they can be linked with parametric variables.

This improvement was already introduced in Tekla Structures **2023 SP6**.
Tekla Structures 2024 comes with a renewed **Property set definitions** dialog box. Now you have better control over model object properties in the IFC exports to satisfy project requirements at each project phase. Creating IFC files that include all necessary property sets mandated by various authorities and stakeholders is easier and more efficient.

The **Property set definitions** dialog box allows you to add and modify property sets needed in the IFC export. New functionalities have been added, which makes the tool more powerful for creating property sets.

- The new dialog box has significant improvements for usability, and no longer requires expert skills or third party applications. The dialog box is now more visual, more intuitive, and easier to learn.

- The **Include** check boxes allow you to have more control over which property sets get exported. You can use **Include** to easily include or exclude property sets or properties without deleting them from the list.

- All property sets to be considered for export are now visible in one place. Also the previously hidden or hard-coded property sets can be seen and applied in the **Property set definitions** dialog box.

- All buildingSMART property sets have been added so you can easily select and export any buildingSMART property set your project might require.

- The new object group filtering allows you to further limit for which objects to export the property set. Previously, when you created a property set for IfcColumn, the property set was exported for all objects that had the IFC entity type IfcColumn selected in the object properties. Now with the new filtering, you can associate property sets only to specific objects that pass
the filter. For example, you could define that only columns made of concrete or of a certain height get exported with a certain property set.

- You can duplicate custom property sets.

To open the new dialog box:

- In the IFC4 Export dialog box or in the Export IFC dialog box for IFC2x3, select a property set configuration file or <new> from the Property sets list and click the Edit button.

The Property sets list now contains all default property sets and custom property sets, and it replaces the old Additional property sets list.

In the following example, one of the default property set configuration files has been selected:

(1) The name of the selected property set configuration file. In the list, you can see all the available configuration files stored in your environment folders, and select the desired file. The file is loaded automatically after selection.

Use the Save button to save the changes in the configuration file after you have added or modified the property sets. You can also give a new name for the configuration file and save it. New and modified configuration files are saved in the \AdditionalPsets folder under the current model folder. You can also read configuration files from the following folders:

XS_FIRM
Use the button to clear the contents of the displayed configuration file and create a new one.

(2) To show in the list only the property sets and properties that you have selected using the Include check box, select Show only included.

(3) Property sets in the current configuration file. All property sets are visible in the list, also the ones that used to be hidden or hard coded. You can drag property sets up or down in the list.

(4) Search for a specific property set. The list of property sets might be very long, and the search could be very useful when you want to find and select a specific property set.

(5) Show only the property sets for certain IFC entities.

(6) Show only the property sets for the selected IFC version.

(7) To export all property sets and all properties in the list, select the Include check box on the title row for the property set or properties section. To export only the needed property sets and properties for different export purposes, select the check box next to the property set or property.

(8) Filters allowing you to further limit for which objects to export the property set. For example, previously when you created a property set for IfcBeam, the property set was exported for all objects that had the IfcBeam IFC entity. Now you can specify a filter to further limit which IfcBeam objects to export the property set for, like for steel beams only.

(9) Clear and intuitive command buttons for working with property sets:

- Add buildingSMART property sets. The property sets beginning with Pset_ or Qto_ are buildingSMART property sets. The buildingSMART property sets are protected, and you cannot change the IFC entities that they are exported with, or edit the names of the property set or the properties they contain.

- Add a property set.

- Edit the selected property set.

- Delete the selected property set.

- Duplicate the selected property set. You can then modify the property set so that the properties are the same but the filtering criteria are different, for example.

(10) Properties in the selected property set. You can drag properties up or down in the list.
(11) To enlarge the property set section or the property section, drag the dialog box divider up or down.

(12) Clear and intuitive command buttons for working with properties:

- Add a property in the selected property set.
- Edit the selected property.
- Delete the selected property from the selected property set.

17.1 Add a new custom property set

1. In the IFC export dialog box in the Property sets list, select an existing configuration file or select <new>.
   When you change the Export type in the export dialog box, the default configuration file will change accordingly in the Property sets list.

2. Click the Edit.

3. To add a custom property set, in the Property set definitions dialog box, in the property set section, click Add property set to this
4. In the **Add property set** dialog box, enter the property set name and description.
   You cannot start the name with `Pset_` or `Qto_`, these prefixes are reserved for buildingSMART property sets.

5. To create an object group filter to further limit for which objects to export the property set, click ![Add](image).

6. Select the IFC entities for the property set.
   You must select at least one entity.

7. Finally, to save the new property set, click **Add**.
   Now you can add properties in the new property set. When you have added all the property sets and properties, click ![Save](image) to save the current configuration file.
17.2 Add properties to a property set

1. In the Property set definitions dialog box, select the property set that you created from the property set list, and in the property section, on the right, click `Add property to this property set`.

   ![Add property dialog box]

   In the displayed Add property dialog box, all the default properties are listed. You can search for properties, or use the Group drop-down list options to narrow down the list according to the object type.

2. Click a property to select it.

   When you have selected a property, the Name, Tekla property, and Type boxes are filled in automatically. You can change the Name of the property. Once you have changed the Name, it no longer changes automatically.

3. To change the type of the property, click the Type drop-down list.
If you select Measurement, more settings are displayed (Measurement type, Conversion, Accuracy).

Tekla Structures 2024 introduces a new drop-down list for the Conversion setting, and you no longer need to know the unit to use for a particular property:

**Accuracy** indicates the accuracy that is used when writing the property to IFC. Enter decimals, for example, 0.1 or 0.01.

You cannot change the Source value, it is either Template or UDA depending on the property you selected.

4. Select the desired values and click Add.

### 17.3 Add a buildingSMART property set

In Tekla Structures 2024, you can add buildingSMART property sets to new or existing property set configuration files. This was not possible in earlier Tekla Structures versions.

1. In the Property set definitions dialog box, open or create a custom property set configuration file where you want to add buildingSMART property sets.

2. Click the ![Import buildingSMART property sets](image) button on the right.
3. Select the property sets that you want to add.
You can search for property sets using the **Search** box. You can also limit the number of the displayed property sets by selecting the desired property set categories, IFC entities, or IFC versions.

4. Select the **Import** check box only for those property sets that you want to add and click **Import**.

The selected buildingSMART property sets are added to the **Property set definitions** dialog box. The buildingSMART property sets are protected, and you cannot edit those, but you can exclude the unnecessary buildingSMART property sets from the export, and change the mapped Tekla properties.
In Tekla Structures 2024, BCF Topics replace the previously used ToDos notes. BCF topics are notes that are added to the linked Trimble Connect project.

BCF stands for BIM Collaboration Format and it is an open industry standard from buildingSMART International. Now, using the BIM Collaboration Format (BCF), you can communicate project-based issues between different BIM applications, such as Tekla Structures, Tekla PowerFab and Trimble Connect, as well as other 3rd party applications. BCF topics are stored and managed in a Trimble Connect project, enabling smoother BIM collaboration workflows. As a result, you can, for example, use BCF topics to communicate within your model directly to the fabricator who is using Tekla PowerFab.

In Tekla Structures, the BCF topics are available in their own side pane window.
You can, for example, add and edit topics, add measurements, markups and comments, and assign topics to users. Before you can start adding BCF topics in Tekla Structures, your model needs to be linked to a Trimble Connect project.

BCF topics can be used with .tekla, .ifc, and .trb files that are created from a Tekla Structures model and uploaded to Trimble Connect.

- A .tekla file that is created when you upload the current Tekla Structures model to a Trimble Connect project. Using a .tekla file is the preferred way of working. If you are using Tekla Model Sharing with a Trimble Connect project, the model is automatically uploaded when you write out or create a new baseline.
- An .ifc file that is created from a Tekla Structures model and uploaded to a Trimble Connect project.
- A .trb file that is created from a Tekla Structures model when exporting to Tekla PowerFab and uploaded to a Trimble Connect project.

Note that ToDos are still available in Trimble Connect and they can be used in Trimble Connect 2D Viewer.
18.1 Create and modify BCF topics

Before you start adding BCF topics in Tekla Structures, ensure that your model is linked to a Trimble Connect project.

Use topics to communicate, assign, track and resolve issues within a project. You can view all the topics that you have created or that have been assigned to you in the Tekla Structures BCF Topics side pane.

1. On the Trimble Connect ribbon tab, click BCF Topics.

   The BCF Topics side pane opens and displays the BCF topics added to the Trimble Connect project.

2. To create a new BCF topic, click the plus button.
The **New topic** page opens.
3. Fill in the fields.
   **Title** is mandatory.

4. Assign the topic to a user or a user group.
   The BCF topics are shared to all project members by default, but you can select a user or a user group to whom you want to assign the BCF topic with a due date when it needs to be resolved.

5. Use **Add references** to add references to documents or links.
   A topic can reference several documents or links. You can add, for example, a PDF file for reference.
   a. Click **Add references**.
   b. On the **Add references** page, select the type of reference that you want to add:
      • under 📦, select the desired reference file from the list of project files.
        Attached project files always point to the latest version of the file stored in the Trimble Connect project.
      • under 📂, browse for a desired reference file to add a new file.
      • under 🟢, add the display text for the desired link and the URL.
   c. Click **Add references**.
   d. To add or remove reference files:
      • to add more reference files, click ➕ to open the **Add references** page.
      • to remove a reference file, click ✗ next to the file.

   You can work with the references also on the **References** page after the BCF topic is created.

6. Use **Add models** to add model files, if needed.
   To enable the collaboration workflow using BCF topics, you need to have a model uploaded to a Trimble Connect project. The preferred way of working is to upload your model as a .tekla file. If you have already uploaded a .tekla file to the linked Trimble Connect project, you do not need to use the **Add models** option.
   If you are using an .ifc or a .trb file instead of a .tekla file, use the **Add models** option to select the file that contains the objects associated to the BCF topic that you are creating in Tekla Structures.
Note that if you are using .ifc or .trb files, you need to manually associate each BCF topic with an .ifc or a .trb file when you create BCF topics in Tekla Structures. You can associate your BCF topics with several .ifc or .trb files at once.

In Trimble Connect the association happens automatically, and therefore the **Add models** command is not available in Trimble Connect. When BCF topics are created in Trimble Connect, Trimble Connect knows which models are visible in the view and stores that information with the BCF topics. These BCF topics will work correctly in Tekla Structures.

a. Click **Add models**.

b. On the **Add models** page, select the type of model file that you want to add:

   - under \(\text{🔍}\), select the desired model file from the list of project files.
   - under \(\text{🔍}\), browse for a desired model file to add a new file.

c. Click **Add models**.

d. To add or remove model files:

   - to add more model files, click \(\text{✚}\) to open the **Add models** page.
   - to remove a model file, click \(\text{✗}\) next to the file.

   You can work with the models also on the **Models** page after the BCF topic is created.

7. Click **Save**.

A view is automatically always added to each new topic.

The saved BCF topic is immediately synchronized to Trimble Connect.

You can then continue by adding, for example, comments and views with graphical markups and measurements.

In Trimble Connect, you can see the BCF topics on the **BCF Topics** page of the linked project.
8. If you want to further edit a BCF topic in Tekla Structures:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define which topics are shown on the Topics page in BCF Topics side pane</td>
<td>In the BCF Topics side pane, click the arrow under Topics and select the option. By default, the Active topics are shown.</td>
</tr>
<tr>
<td>Sort the topics</td>
<td>In the BCF Topics side pane, click at the top of the side pane and select the sorting option. The default sorting order is by Creation date.</td>
</tr>
<tr>
<td>Edit a topic</td>
<td>You can edit topics that you have created or that have been assigned to you.</td>
</tr>
<tr>
<td>a.</td>
<td>In the BCF Topics side pane, select the BCF topic that you want to edit. The topic opens on its own page.</td>
</tr>
<tr>
<td>b.</td>
<td>Click Edit.</td>
</tr>
<tr>
<td>c.</td>
<td>Adjust the BCF topic information according to your needs.</td>
</tr>
<tr>
<td>d.</td>
<td>To save the changes, click Save.</td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Assign a topic</td>
<td>You can assign topics that you have created or that have been assigned to you.</td>
</tr>
<tr>
<td></td>
<td>a. In the <strong>BCF Topics</strong> side pane, select the BCF topic that you want to assign to someone. The topic opens on its own page.</td>
</tr>
<tr>
<td></td>
<td>b. Click <strong>Edit</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. In the <strong>Assignee</strong> field, enter the names of the users or the user groups. There can be multiple users or user groups listed in the <strong>Assignee</strong> field.</td>
</tr>
<tr>
<td></td>
<td>d. To save the changes, click <strong>Save</strong>.</td>
</tr>
<tr>
<td>Remove a topic</td>
<td>You can delete only the topics which you have created. Deleting topics from the project cannot be undone. If you delete a topic, the topic will be deleted for everyone for who it has been assigned to. All the data is deleted as well.</td>
</tr>
<tr>
<td></td>
<td>a. In the <strong>BCF Topics</strong> side pane, select the BCF topic that you want to remove.</td>
</tr>
<tr>
<td></td>
<td>b. Click <strong>Remove</strong>.</td>
</tr>
<tr>
<td></td>
<td>c. Click <strong>Delete</strong>.</td>
</tr>
</tbody>
</table>
The model representation in the .tekla file upload to Trimble Connect has been improved.

Now, when you upload a Tekla Structures model to Trimble Connect,

- slotted holes are visible in Trimble Connect even when the bolts are on
- rounding on profiles is visible in Trimble Connect

You can control the visibility of profile rounding using the advanced option XS_HIGH_ACCURACY_TRIMBIM_EXPORT. The advanced option is set to TRUE by default, meaning that the rounding on profiles is visible.
• surface treatment is visible in Trimble Connect
• surface objects are visible in Trimble Connect

Additionally:
• if the assembly export is enabled: rebars now belong to the part's assembly (similarly as in the IFC export) and not to the part itself
• if assembly export is disabled: rebars belong to the part, as they have previously done
Tekla Structures 2024 introduces the 3D PDF export for exporting the current model or the selected model objects as a 3D PDF file. The 3D PDF allows you to easily communicate your work to others without needing to download and install an extension: all the receiver needs is a PDF reader that supports the 3D PDF format.

Alternatively, share your models via the public Trimble Connect link.

The 3D PDF looks exactly like the original 3D design. Using this tool reduces design errors, improves the quality of the project, and increases productivity, leading to improved communication and faster decision making.

We recommend that you use Adobe Acrobat Reader, as all PDF readers do not support the 3D PDF format.

The various options in the 3D PDF export allow you to:

- Export the whole model or the selected parts of it.
- Select the objects to include in the PDF:
  - Fasteners
  - Reinforcement
  - Bolts
  - Welds
  - Grids
  - Part properties
- Export additional properties for the objects using property sets defined for the IFC export.
- Export objects as assemblies, which means that Tekla Structures automatically selects the corresponding assembly of the objects for the export.
- Use the current model view colors in the 3D PDF.
• Show the model information either by phases or by objects in the 3D PDF model tree. When you have included part properties in the export, part properties will be displayed in the model tree when a part is selected.

• Show the objects either with normal or high solid accuracy.

• Define the page settings (size, orientation) and select the suitable model and view settings (background color, light definition, rendering mode).

• Open the export folder and/or the 3D PDF file after the export.

• Create the U3D format file only. The Universal 3D (U3D) format is a compressed file format standard for 3D computer graphics data.

**Publish to 3D PDF** is also available as an extension in Tekla Warehouse.

**How to export in the 3D PDF format**

• To start the export, in modeling mode, click **File --> Export --> 3D PDF**.

![3D PDF export interface](image)

• Check the settings on the **File, PDF, and Model content** tabs, and adjust the settings to suit your needs.

• If you want to export some objects only, select the objects in the model, and select **Selected objects** as the **Scope of export**. To export the whole model, select **All objects**.

• When you are ready, click **Publish**. By default, the PDF file is exported to the \PDF folder under the current model folder.

You can open the resulting 3D PDF in a PDF reader and explore the model using the tools available in the reader.
Below is an example of the 3D PDF in Adobe Acrobat Pro. Model objects are listed in the model tree by phases.

Below is an example of part properties for a column in the model tree. An IFC property set configuration file has been selected from the Additional property sets list in the export settings, and some additional properties are listed.
<table>
<thead>
<tr>
<th>Property</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application.FullName</td>
<td>Tekla Structures</td>
</tr>
<tr>
<td>Application.Identifier</td>
<td>Multi material modeling</td>
</tr>
<tr>
<td>Application.Version</td>
<td>Work</td>
</tr>
<tr>
<td>GUID</td>
<td>3JRTKpy5E_fVzTtxb6U</td>
</tr>
<tr>
<td>Organization.Name</td>
<td>Trimble Solutions Corporation</td>
</tr>
<tr>
<td>OwnerHistory.ChangeAction</td>
<td>NoChange</td>
</tr>
<tr>
<td>OwnerHistory.CreationDate</td>
<td>Wed Jun 2 10:00:00 2021</td>
</tr>
<tr>
<td>OwnerHistory.State</td>
<td>Undefined</td>
</tr>
<tr>
<td>Person.FamilyName</td>
<td>Undefined</td>
</tr>
<tr>
<td>Person.Id</td>
<td></td>
</tr>
<tr>
<td>Product.Description</td>
<td>HEA600</td>
</tr>
<tr>
<td>Product.Name</td>
<td>COLUMN</td>
</tr>
<tr>
<td>Property.AssemblyActualEnd</td>
<td>Sun Jan 28 02:00:00 2024</td>
</tr>
<tr>
<td>Property.AssemblyActualStart</td>
<td>Sun Jan 7 02:00:00 2024</td>
</tr>
<tr>
<td>Property.AssemblyErectionCompleted</td>
<td>DONE</td>
</tr>
<tr>
<td>Property.AssemblyErectionComplete</td>
<td>002</td>
</tr>
<tr>
<td>Property.AssemblyErectionComplete</td>
<td>CLEARN</td>
</tr>
<tr>
<td>Property.AssemblyErectionComplete</td>
<td>80%</td>
</tr>
<tr>
<td>Property.AssemblyPlannedEnd</td>
<td>Sun Oct 29 03:00:00 2023</td>
</tr>
<tr>
<td>Property.AssemblyPlannedStart</td>
<td>Sun Oct 1 03:00:00 2023</td>
</tr>
<tr>
<td>Property.COG_X</td>
<td>24000.0000000 mm</td>
</tr>
<tr>
<td>Property.COG_Y</td>
<td>0.0000000 mm</td>
</tr>
<tr>
<td>Property.COG_Z</td>
<td>3610.0000000 mm</td>
</tr>
<tr>
<td>Property.END_X</td>
<td>24000.0000000 mm</td>
</tr>
<tr>
<td>Property.END_Y</td>
<td>0.0000000 mm</td>
</tr>
<tr>
<td>Property.END_Z</td>
<td>7200.0000000 mm</td>
</tr>
<tr>
<td>Property.Name</td>
<td>HEA600</td>
</tr>
<tr>
<td>Property.START_X</td>
<td>24000.0000000 mm</td>
</tr>
<tr>
<td>Property.START_Y</td>
<td>0.0000000 mm</td>
</tr>
<tr>
<td>Property.START_Z</td>
<td>0.0000000 mm</td>
</tr>
</tbody>
</table>
You can now import portal frame connection information and column base plates from Tekla Structural Designer into Tekla Structures.

**NOTE**  A Tekla Structural Designer license is required to import data into Tekla Structures and must be purchased separately. The data transfer functionality is not included in the Tekla Structures license.

Compatible versions of Tekla Structural Designer and Tekla Structures must be installed on the same computer.

Use Tekla Structural Designer model files (.tsmd) in the import. Neutral files in .cxl format do not support the import of portal frame connection information or column base plates.

### 21.1 Import portal frame connection information

To complete your moment connection detailing of portal frame structures in Tekla Structures, you can now import accurate geometrical haunch information that was used to design the frame in Tekla Structural Designer: the haunch length, depth, section profile, and the end plate details.

Components that are automatically created for imported portal frames in Tekla Structures are **Eaves haunch (102)** and **Apex haunch (106)**, and the applied component values match the structural engineering requirements.

Note that no bolt, stiffener, or weld information is currently transferred.

Portal frames are generally relevant to the following regions: United Kingdom, Republic of Ireland, South Africa, Singapore, and Malaysia.
21.2 Import column base plates

Column base plates designed in Tekla Structural Designer are now included in the import into Tekla Structures. Base plate components (1042 for metric models and 1047 for US imperial models) are automatically generated, matching the details provided during the design phase, i.e. end plate geometry, bolts, anchorage, and weld information.

Note that no stiffener information is currently transferred.
Other interoperability improvements

Tekla Structures 2024 comes with important improvements in reference models, point clouds, Layout manager, DSTV/NC export, IFC export, ELiPLAN export, BVBS export, and some interoperability links.

22.1 Improvements in reference models

Hide or show all reference models at one go

You can now hide or show all reference models in the Tekla Structures model at one go with the new All button.

![All button]

This improvement was already introduced in Tekla Structures 2023 SP1.

Use project location when inserting IFC2x3 reference models

When inserting an IFC2x3 reference model that has a project location available, you can enable the project location by setting the new model-specific advanced option XS_USE_PROJECT_LOCATION_IN_IFC2X3_IMPORT to TRUE in the Import category of the Advanced options dialog box. When this advanced option is set to TRUE, the project location is applied and the
reference model is inserted away from the Tekla Structures model origin. The default value is FALSE.

22.2 IFC export improvements

IFC export now supports exporting spaces
The IFC2x3 export and IFC4 export now support the export of spaces. To export spaces:

• IFC2x3 export: Select the Spaces option in the Object types section on the Advanced tab.
• IFC4 export: Select the Spaces option in the Object types section.

IFC4 export: Project properties used if object property not found
When an attribute or a property is not found from the object itself, Tekla Structures tries to fetch it from the project.

22.3 Improvements in point clouds
Point clouds now support files from Trimble X9 3D Laser Scanning System. Now you can import your point clouds in native TZF and TDX formats generated by Trimble X9. TDX is a project format containing TZF as well as RWCX. The enhanced TZF files keep the file sizes reasonable for the higher quality point clouds allowing you work efficiently with better quality scan data.

22.4 Improved Layout manager workflow

Layout manager workflow has been enhanced to improve the communication between the model and the site.

CSV file import and export
You can now import and export layout points in CSV files (.csv) in Layout manager to get control points directly into your model. When using CSV files, there is no need to change the file extensions or delimiters anymore to use the files.

Improved visualization of imported points
It is now easier to compare the as-built conditions inside your model, and update the model according to how it is actually built on the site.

All supported design point types imported from Trimble FieldLink files (.tflx) are now shown in the Layout manager dialog box using different colors and

Other interoperability improvements 111 IFC export improvements
symbols, depending on the visual classification type of the point. The imported points are shown in the model by the class color that most closely matches the color of the point icon.

Supporting more symbols and colors offers more precise information on the layout, making it easier for you to navigate the layout both on the site and in the model.

**Point grouping support in point files**

You can now import and export point files (.txt) that contain the group names of exported points. The group names are listed in the files under a new column called GROUP.

**Inches supported**

*Layout manager* now supports importing coordinates from .txt and .csv files that are specified in inches (in).

Also, coordinate units are now shown in the header rows in the *Layout manager* import and export dialog boxes so that it is easy to see which units are used.

**Layout manager now supports layout arcs**

You can now import and export layout arcs in .tflx files in *Layout manager*. This improvement was already introduced in Tekla Structures 2023 SP1.

---

### 22.5 Improvements in DSTV/NC

**Control writing sawing angles to NC for profiles**

If you do not want to write sawing angles to the NC file header for profiles, set the new, model-specific advanced option `XS_DSTV_NO_SAWING_ANGLES_FOR_PROFILES_NEEDED` to TRUE. This advanced option was added to support the identical functionality for plates, and cases where the AK block is preferred by a DSTV viewer or NC machine. The default value FALSE means that sawing angles will be written to the NC file header for profiles. This new advanced option is located in the **CNC** category of the **Advanced options** dialog box.

Earlier, when the advanced option `XS_DSTV_CREATE_AK_BLOCK_FOR_ALL_PROFILES` was set to FALSE, NC file headers were created with no sawing angles. Now the writing of sawing angles has been changed to follow the advanced option `XS_DSTV_NO_SAWING_ANGLES_FOR_PROFILE_NEEDED`.

**Improved radial cuts in NC**

Radial cuts in a slightly angled beam are now exported to NC with the correct geometry.
Before the fix:

After the fix:

Placing of holes in DSTV/NC export

- Earlier, when you exported a plate or an I beam and selected the option to rotate the part to get pop-marks in the front side, regular holes in the front side were moved to the back side. This has now been fixed, and regular holes now follow the side of the AK block, making the fabrication more efficient.

- Earlier, when you exported L profiles, through holes could be created on top or bottom profile faces, causing missing holes in certain viewers. Now the BO block for these holes is always created on the bottom face.

22.6 Improvements in BVBS export

Coupler export settings moved to Mechanical connections tab

Settings related to coupler export have been moved from the Advanced tab to the new Mechanical connections tab.

On the Mechanical connections tab, set Export reinforcement coupler data to Yes to export coupler or thread data. Then enter the UDAs for the connection method, product, and product code for the rebar start and rebar...
Define reinforcement position using multiple template attributes
You can now use multiple template attributes when you define the reinforcement position using the Reinforcement template option on the Data content tab. Use empty space as a separator between the template attributes. For example, enter SHAPE POS.

New option for defining a mapping file for materials and grades
Now the name of the reinforcement material or grade can be mapped to another name, which is defined in a mapping file. You can define the mapping file using the new option, Mapping file, on the Parameters tab. This feature allows you to match the requirements of the software processing of the BVBS data if there are different reinforcement materials or grades to be used. By default, the mapping file is located in the model folder, but it can also be used from the folders defined by the advanced options XS_SYSTEM, XS_PROJECT, and XS_FIRM.

22.7 Improvements in ELiPLAN export
The Project number field on the Data content tab now accepts up to 12 characters. This is the maximum number of characters that the export file accepts.

22.8 Updates in interoperability links
The links to the following solutions have been updated: Autodesk Robot, Bentley STAAD Pro, SAP2000, ETABS, and Smart3D. The links now export results more reliably so that less checks and rework is required.
You can now select the geographical location where the Tekla Model Sharing model data is stored.

The possibility to select where the model data is stored and accessed for each project helps to comply with project requirements where the data is required to be stored in a specific geographical location.

The data storage location can be selected only when you start to share a model. If you use the on-premises sharing service for Tekla Model Sharing, you cannot select the data storage location.

1. On the **File** menu, click **Sharing --> Start sharing**.
   The **Start sharing** dialog box opens.
2. Select the service from the **Service** list. If needed, enter a **Code** and a **Description** for the model.
3. In **Model data storage location**, select the location for the model data storage.

There are four model data storage locations available: North America (Virginia/East US), Australia (New South Wales/Australia East), Asia (Singapore/Southeast Asia), and Europe (Ireland/North Europe). The locations are the same locations as in Trimble Connect.

Select the region closest to the majority of the users in the model to improve the performance.

Note that you can set the data storage location only if the Tekla Model Sharing administrator of your organization has allowed that in Management Console for Tekla Model Sharing. Administrators can set a default data storage location to be used in the organization. For more information, see Manage organization settings in the Management Console.

4. Invite users to the model, and click the **Start** button to start sharing your model.

After the model is shared, the model data storage location is visible in the **Users and data** dialog box.
Model data storage location: Europe
Integrated link to Tekla Tedds for simple connections

Tekla Structures 2024 provides ribbon commands for Tekla Tedds Integrator allowing you to link Tekla Tedds calculation documents to your Tekla Structures model. You can link existing documents or create new documents, which you or other Tekla Structures users can then easily modify or review during the BIM workflow. The integration reduces the amount of manual work that the detailer or engineer has to undertake in Tekla Structures thus improving productivity.

**NOTE** The Tekla Tedds Integrator ribbon tab is shown only if it has been set visible in your environment or role by your administrator. For more information, see Administrator’s release notes: Integrated link to Tekla Tedds for simple connections (page 161).

For example, using Tekla Tedds Integrator you can check that a simple steel connection in a Tekla Structures model is compliant with Eurocode design. You can quickly modify the design using the Tekla Tedds calculations until all the code-compliant design checks are satisfied. Then you can return the modified design to the Tekla Structures model and automatically update the geometry and configuration of the steel connection to reflect the modified design.

When using Eurocode design, Tekla Tedds Integrator includes built-in automatic data transfer for simple steel connections, structural concrete, and precast concrete elements. For other structural design codes, you can manually select the calculation to use, in which case no data is transferred. You can also add your own integration links, see the Tekla Tedds Integrator Reference Guide for details on how this can be achieved.

Tekla Tedds Integrator supports different levels of design integration. The linking method that is used depends on the structural element selected in the Tekla Structures model.

- **Data linking**: If the integrator is able to identify the structural element you selected in the Tekla Structures model, the appropriate Tekla Tedds calculation will be automatically selected and any appropriate design information available from the model object, such as geometry and
material, will be automatically transferred to the Tekla Tedds calculation. When the design is completed, the Tekla Structures model object will be updated as appropriate and the documentation will be linked to the model object.

- **Document linking**: If the integrator is unable to identify the structural element you selected in the Tekla Structures model, you will be asked to choose which Tekla Tedds calculation to use to create your design documentation. When the design is completed, the documentation will then be linked to the model object.

**Tekla Tedds ribbon tab in Tekla Structures**

The new Tekla Tedds ribbon tab in Tekla Structures provides commands for integrating Tekla Structures model objects and Tekla Tedds calculations:

![Tekla Tedds ribbon tab](image)

Tekla Tedds Integrator is also available as an extension in Tekla Warehouse, and you can use the extension with older Tekla Structures versions.

**Tekla Tedds application**

Tekla Tedds is an easy to use application that engineers can rely on for accurate calculations. With Tekla Tedds, engineers can streamline engineering design, avoid errors, and present output professionally. For more information about Tekla Tedds, see [Tekla User Assistance for Tekla Tedds](#).

To use Tekla Tedds Integrator, you need to have the Tekla Tedds application installed on your computer. You do not need to start the Tekla Tedds application to use the integrator commands, the commands will launch Tekla Tedds automatically when it is needed. For more information about the Tekla Tedds installation, see [Tekla Tedds installation and licensing workflow](#).

Tekla Tedds needs to be purchased separately, it is not included in the Tekla Structures license.

To launch the Tekla Tedds application from Tekla Structures to do some manual work with Tekla Tedds:

- On the Tekla Tedds ribbon, click **Tedds**.

### 24.1 Start Tekla Tedds integration

Ensure you have the Tekla Tedds application installed on your computer.

1. Select an object in the Tekla Structures model.
2. On the **Tekla Tedds** ribbon tab, click New.

3. Do one of the following depending on the linking method:

   **Data linking method**

   If the structural identity of the object can be determined, the data linking method will be used, and the appropriate calculation will start automatically.

   - Geometric information related to the section shape, governing dimensions, member length and material will be automatically populated.
   - Some information is not transferred from Tekla Structures to the Tekla Tedds calculation, such as loads and bending moments (where applicable), slenderness information, or the national annex to be used. Where values are not transferred from Tekla Structures, the default values applicable for the Tekla Tedds calculation will be populated.
   - Once the Tekla Tedds design calculation has been completed, click the Finish button to complete the design. A dialog box will be displayed where you can save the documented results of the calculation. We recommend that you save the documents in a subfolder under the Tekla Structures model folder, which will ensure that the documents are transferred with the model, for example, when using Tekla Model Sharing.
Document linking method
If the integrator is unable to identify the structural element, the document linking method will be used, and you will be asked to choose which calculation to use.

- From the list, select the required calculation and then click the **Calculate** button. The calculation dialog box is displayed.
For document linking, no information is transferred from Tekla Structures to Tekla Tedds. Instead of information transfer, the default values applicable for the Tekla Tedds calculation will be populated.

• Once the Tekla Tedds design calculation has been completed, click the Finish button to complete the design. A dialog box will be displayed...
where you can save the documented results of the calculation. Save the documents in a subfolder under the Tekla Structures model folder.

### 24.2 Working with Tekla Tedds Integrator

Tekla Tedds ribbon tab contains the following commands for keeping the design up to date:

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tedds</td>
<td>Launch the Tekla Tedds application to do some manual work with Tekla Tedds. You do not need to launch Tekla Tedds separately to use the other commands on the Tekla Tedds ribbon, these commands will launch the Tekla Tedds application automatically when it is needed.</td>
</tr>
<tr>
<td>New</td>
<td>Create a new Tekla Tedds document for the selected model object. If the structural identity of the object can be determined, the appropriate calculation starts automatically. Otherwise, you are asked to select a calculation.</td>
</tr>
<tr>
<td>Add</td>
<td>Link an existing Tekla Tedds document (.ted) to the selected model object. The Select Tedds document dialog box will be displayed allowing you to browse for and select any previously saved Tekla Tedds document.</td>
</tr>
<tr>
<td>Update</td>
<td>Update the Tekla Tedds document linked to the selected model object with the current data from the Tekla Structures model, recalculate the document, and update the model from the completed Tekla Tedds design.</td>
</tr>
<tr>
<td>Update document</td>
<td>Update the Tekla Tedds document linked to the selected model object with the current data from the Tekla Structures model and recalculate the document. Do not update the Tekla Structures model.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update model</td>
<td>Recalculate the Tekla Tedds document linked to the selected model object using the existing design data and then update the Tekla Structures model from the completed Tekla Tedds design.</td>
</tr>
<tr>
<td>Open</td>
<td>View and modify a Tekla Tedds document that is linked to the selected Tekla Structures model object.</td>
</tr>
<tr>
<td>Remove</td>
<td>Remove a Tekla Tedds document linked to the selected Tekla Structures model object. Here, removing means simply removing the association between the Tekla Structures object and the saved Tekla Tedds document. The document still remains in the saved location so that it may be added again if required using the Add command. If the Remove command is used, the Tedds document UDA will be set to No.</td>
</tr>
<tr>
<td>Project</td>
<td>Send all Tekla Tedds documents linked to the model to a new project in the Tekla Tedds application. This creates a new project, which includes all of the Tekla Tedds calculations associated with the currently opened Tekla Structures model. You can then use the commands within Tekla Tedds to modify various aspects of the project. You can change the documentation order and modify the calculation headers, for example. Use the Save project command to keep the project saved with any modified settings and available for future sessions of the Tekla Tedds application.</td>
</tr>
<tr>
<td>Tools - Object browser</td>
<td>Open a separate dialog box allowing you to view the properties of the selected model object. This is particularly useful when writing your own integrations.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Tools - Options</td>
<td>Modify Tekla Tedds Integrator settings, such as settings related to logs. The dialog box also contains buttons for opening some folders in Windows File Explorer, such as the folder where log files are stored.</td>
</tr>
</tbody>
</table>
24.3 Tekla Tedds user-defined attributes

Once a Tekla Tedds document has been linked to an object in the Tekla Structures model, the object will get two user-defined attributes.

**Tedds document:** This attribute indicates whether a Tekla Tedds document is associated with an object or not. The name of the user-defined attribute is TEDDS_DOCUMENT, and the value is either Yes or No.

**Tedds identity:** This Tekla Tedds Integrator attribute is populated only when you use the New or Update commands for an object which is supported by data linking. The attribute identifies which Tekla Tedds calculation should be used by the integrator. The name of the user-defined attribute is TEDDS_IDENTITY, and the value is a structural identity name as defined by the Tekla Tedds Integrator identity provider feature.
24.4 Tekla Tedds representation

Tekla Tedds integration comes with a new view representation for use within Tekla Structures called **Tedds Documents**. This representation uses a filter based on the **Tedds document** UDA. Any part that has this attribute with the value **Yes** will be colored as green. All other parts will be colored as gray.
Integrated link to Tekla Tedds for simple connections

Tekla Tedds representation
Integrated Bridge creator for bridge design

The **Bridge creator** component that was previously available in Tekla Warehouse is now included in the Tekla Structures 2024 installation. You can now start working on your bridge projects in Tekla Structures without extra downloads and installations.

You can access **Bridge creator** using the **Applications & components** catalog in Tekla Structures.

If you are using the **Bridge designer** role in the Default environment, you can find **Bridge creator** easily also on the **Bridges** tab on the ribbon.

**Bridge creator** includes all the bridge design capabilities from Trimble Novapoint, and allows you to:

- Place tension cables using .xls (Microsoft Excel) input

  Note that in addition to bridges, this functionality can also be utilized when modeling other long-span structures, such as tensioned beams and slabs in wide-span buildings.

- Import road alignments in LandXML format, or use construction lines

- Define complex cross sections

- Use absolute or relative levels for longitudinal extrusion of cross sections along the road line

- Extrude the deck with parabolic longitudinal variation to create an arch underneath the deck

- Place detailed components and beams constrained along any line

The other bridge tools, **Beam extruder** and three cast-in-place reinforcement tools, are still available as extensions in Tekla Warehouse.

For more instructions for **Bridge creator**, see the **Using Bridge creator** section in Tekla User Assistance.
There are many improvements in concrete components and steel components in Tekla Structures 2024.

The following Tekla Structures 2023 service packs also introduced improvements in components, see:

- 2023 SP1: Important improvements and fixes
- 2023 SP3: New features and improvements
- 2023 SP4: New features and improvements
- 2023 SP5: New features and improvements
- 2023 SP6: New features and improvements
- 2023 SP8: Important improvements and fixes

### 26.1 Concrete components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Floor layout** | • The functionality of the *User defined* tab has been improved so that you can now define the name of the tab and, if needed, also define more than one *User defined* tab each with its own name. Previously, there was only one tab page available and the tab name was hardcoded.  

Note that as a result of this improvement, the name of the tab defined in an existing `floorlayout.objects.inp` file is now visible in the **Floor layout** dialog box. Previously, it was... |
<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Hollowcore lifting loops</strong></td>
<td>You can now specify the name and material for recess cuts on the new <strong>Cut settings</strong> tab.</td>
</tr>
<tr>
<td><strong>Sandwich wall window</strong></td>
<td>• You can now define offsets for the insulation extension on the <strong>Extra foils</strong> tab.</td>
</tr>
<tr>
<td></td>
<td>• You can now define a <strong>Class</strong>, and a <strong>UDA name</strong> and <strong>Value</strong> for extension parts (1) and (4) on the <strong>Bottom detail</strong>, <strong>Left detail</strong>, <strong>Right detail</strong>, and <strong>Top detail</strong> tabs.</td>
</tr>
<tr>
<td><strong>Wall layout elementation</strong></td>
<td>There are now two new options for creating seams:</td>
</tr>
<tr>
<td></td>
<td>• <strong>By exact length</strong> for defining the exact lengths of the wall pieces to which the wall layout is divided.</td>
</tr>
<tr>
<td></td>
<td>• <strong>By equal length</strong> for defining the minimum and maximum length of a wall piece. The wall layout is divided into pieces that are of equal length.</td>
</tr>
<tr>
<td><strong>Braced girder (88), (89)</strong></td>
<td>On the <strong>Geometry</strong> tab, you can now use the new <strong>Cut</strong> setting to select whether the entire braced girder is</td>
</tr>
</tbody>
</table>
### Component Description

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cut at openings, or only the parts that collide with openings.</td>
<td></td>
</tr>
<tr>
<td>Border rebar for single edge (93)</td>
<td>On the <strong>Configuration</strong> tab, there is a new setting, <strong>Cast unit geometry</strong>. You can set it to <strong>Yes</strong> to specify that reinforcement is created using the geometry of all parts inside the cast unit, instead of the selected part only.</td>
</tr>
<tr>
<td>Rebar coupler and anchor tools</td>
<td>Before you create rebar couplers and end anchors for reinforcing bars, you can now use the new advanced option <code>XS_REBAR_END_SPECIFIC_UDA_METHOD</code> to control which user-defined attributes are added to bar ends. Use the default value <code>START_AND_END</code> to create start leg and end leg UDAs, or set the advanced option to <code>SHORT_AND_LONG</code> to create short leg and long leg UDAs.</td>
</tr>
</tbody>
</table>

## 26.2 Steel components

<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cold rolled overlap (1)</td>
<td>You can now specify on the <strong>Stays</strong> tab that only stay bolts are created without creating stay profiles or plates.</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Welded gusset (10), Bolted gusset (11)</strong></td>
<td>You can now specify the vertical dimension from the gusset plate edge to the flange of the main part on the <strong>Gusset</strong> tab. Previously, you could only define the horizontal dimension.</td>
</tr>
<tr>
<td><strong>Bracing cross (19)</strong></td>
<td>You can now specify the bolt Cut length on the <strong>Bolts</strong> tab.</td>
</tr>
<tr>
<td><strong>Tube gusset (20)</strong></td>
<td>You can now define ventilation holes in end plates on the <strong>Brace conn</strong> tab.</td>
</tr>
<tr>
<td><strong>Pipe column and beam panel zone (21)</strong></td>
<td>You can now specify the Finish part property for all parts on the <strong>Panel parts</strong> tab.</td>
</tr>
<tr>
<td><strong>Bolted cap plate (27)</strong></td>
<td>The welds dialog box for Bolted cap plate (27) now has an image of weld placement.</td>
</tr>
<tr>
<td><strong>Seating cap (37), Seating (39)</strong></td>
<td>On the <strong>Picture</strong> tab, you can now define the end plate width from the main part edges. On the <strong>Parts</strong> tab, you can define the round end plate dimensions.</td>
</tr>
<tr>
<td><strong>Stiffened end plate (27), Partial stiffened end plate (65)</strong></td>
<td>• On the <strong>Picture</strong> tab, you can now specify a gap between the front plate and the main part.</td>
</tr>
<tr>
<td></td>
<td>• On the <strong>Parts</strong> tab, there are now two new options for better...</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Controlling the width and height of the shim plates.</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Haunch (40)</strong></td>
<td>You can now specify on the Extra plates tab that one bolt plate is created for each row of bolts in the bolt group.</td>
</tr>
<tr>
<td><strong>Corner tube gusset (56)</strong></td>
<td>You can now define the size of square end plates, and the chamfer type and dimensions on the Brace conn tab.</td>
</tr>
<tr>
<td><strong>Splice type 1 (56)</strong></td>
<td>You can now define the assembly prefix and start number for the web plate on the Parts tab.</td>
</tr>
<tr>
<td><strong>Vertical bracing (S56)</strong></td>
<td>The way you pick the input points when creating the component has been changed. Previously, you had to pick points that had been created as model objects. Now you can pick the</td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
</tr>
<tr>
<td>Brace end positions using any model points.</td>
<td>Wraparound gusset (58), Wraparound gusset cross (60), Gusseted cross (62)</td>
</tr>
<tr>
<td>You can now set the gusset plate as the main part for the bolts that connect the gusset plate to the main part or the last secondary part by setting the bolt type to <strong>Workshop</strong>.</td>
<td>Wraparound gusset (58), Wrapped cross (61), Gusseted cross (62), Corner gusset (63)</td>
</tr>
<tr>
<td>On the <strong>Brace conn</strong> tab, you can now specify that a weld is created between the filler plate and the secondary part. You can use this setting when the connection type is bolts.</td>
<td>Cage ladder (S60)</td>
</tr>
<tr>
<td>On the <strong>Parameters</strong> tab, you can now define chamfers to the top of the rail bars.</td>
<td>Stairs (S71), Wooden steps pan (S72), Polybeam pan (S73), Z pan (S74)</td>
</tr>
<tr>
<td>Welds number 2 and 3 are now controlled by the <strong>Create assembly</strong> option on the <strong>Stair setup</strong> tab.</td>
<td>Stairs S71</td>
</tr>
<tr>
<td>You can now specify a different custom component for the first step, last step, and middle steps on the <strong>Steps</strong> tab.</td>
<td>Z pan (S74)</td>
</tr>
<tr>
<td>You can now specify the creation of horizontal and vertical brackets for the top and bottom step on the <strong>Horizontal bracket</strong> and <strong>Vertical bracket</strong> tabs.</td>
<td>Splice connection (77)</td>
</tr>
<tr>
<td>You can now use the new <strong>By images</strong> option to create a <strong>Splice plate assembly</strong> based on the image options on the <strong>Parameters</strong> tab.</td>
<td>Stanchion side plate (83)</td>
</tr>
<tr>
<td>You can now define the <strong>Cut length</strong> on the <strong>Bolts</strong> tab.</td>
<td>Eaves haunch (102)</td>
</tr>
<tr>
<td>You can now specify the horizontal position of the plate and bolts on the <strong>Vertic/Rafter</strong> tab.</td>
<td></td>
</tr>
<tr>
<td>Component</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Stub connection (119)                    | • You can now specify part numbering prefixes and start numbers for all parts on the Parts tab.  
• You can now define the width and height of **End plate 2** on the Parts tab. |
| Bolted moment connection (134)           | You can now specify different bolt properties for upper and lower flange bolts. |
| Clip angle (141), Two sided clip angle (143) | On the **Bolts** tab, you can now control the vertical bolt group position when the secondary part is sloped. |
| Two sided clip angle (143)               | There are now two new safety connection types on the **Parts** tab. 
Clip angles are moved up to create a safety connection: |
|                                          | Clip angles are notched at the bottom to create a safety connection: |
| End plate (144)                          | The component now works with secondary parts created from welded plates.     |
| Shear plate simple (146)                 | • You can now separately specify slotted holes and bolt length increase for the top and bottom bolts on the **BoxP Bolts** and **BoxSB Bolts** tabs.  
• On the **Notch** tab, there is a new setting **Clearance of cut from web** that you can use to define a tolerance value for the beam web |
<table>
<thead>
<tr>
<th>Component</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>cut. The value defines the portion of the web that is not cut.</td>
<td></td>
</tr>
<tr>
<td><strong>Angle profile box (170)</strong></td>
<td>You can now select different profiles and define different properties for the top angle and bottom angle. The weld settings for the angles are also separate now.</td>
</tr>
<tr>
<td><strong>Shear stud (1010)</strong></td>
<td>You can now select on the <strong>Picture</strong> tab whether to create shear studs as profiles, studs, or bolts. You can also specify the profile, bolt, and stud properties.</td>
</tr>
<tr>
<td><strong>Stair base detail (1043)</strong></td>
<td>You can now use weld 3 as the weld between the vertical plate and the main part, and weld 4 as the weld between the angle cleat profile and the main part.</td>
</tr>
<tr>
<td><strong>U.S. Base plate (1047)</strong></td>
<td>• You can now specify the Gage material UDA for cast plates on the <strong>Parts</strong> tab. This option is available in the USA environment only.</td>
</tr>
<tr>
<td></td>
<td>• You can now use weld number 6 to weld a main part created with an RH profile to the base plate. Also, the creation of weld number 2 has been fixed for main parts with profiles RH, C, U, and L.</td>
</tr>
</tbody>
</table>
In Tekla Structures version 2024, there are some new advanced options, and some of the advanced options have become obsolete. Also, the functionality of some of the advanced options has been changed.

You can use advanced options for configuring Tekla Structures to suit the way you work, or to comply with specific project requirements or industry standards. You can change advanced options values in the Advanced options dialog box, or in the initialization files.

### 27.1 New advanced options

**XS_SHORTENING_SYMBOL_COLOR_RGB**

Use this new model-specific advanced option, XS_SHORTENING_SYMBOL_COLOR_RGB, to define the color of the view shortening symbol in a drawing. Leave the value empty to automatically use the same color as the part color.

You can enter a single color index value (such as 160 for the standard Tekla Structures red color) or a specific custom RGB color. For an RGB color, enter three numeric values separated by spaces (each value in the range 0 to 255). For example, for a specific shade of green, enter 0 220 50.

This advanced option is located in the Drawing properties category of the Advanced options dialog box and it replaces the advanced option XS_SHORTENING_SYMBOL_COLOR.

**XS_SECTION_LINE_COLOR_RGB**

Use this new model-specific advanced option, XS_SECTION_LINE_COLOR_RGB, to add extra lines in different colors around automatic hatching in section views.

You can enter a single color index value (such as 160 for the standard Tekla Structures red color) or a specific custom RGB color. For an RGB color, enter three numeric values separated by spaces (each value in the range 0 to 255). For example, for a specific shade of green, enter 0 220 50.
This advanced option is located in the **Hatching** category of the **Advanced options** dialog box and it replaces the advanced option **XS_SECTION_LINE_COLOR**.

**XS_POP_MARK_COLOR_RGB**

Use this new model-specific advanced option, **XS_POP_MARK_COLOR_RGB**, to define the color of a customized pop-mark symbol that is displayed in a drawing. The default value is 1 (white).

You can enter a single color index value (such as 160 for the standard Tekla Structures red color) or a specific custom RGB color. For an RGB color, enter three numeric values separated by spaces (each value in the range 0 to 255). For example, for a specific shade of green, enter 0 220 50.

This advanced option replaces the advanced option **XS_POP_MARK_COLOR** and is located in the **Drawing properties** category of the **Advanced options** dialog box.

**XS_SHOW_EMPTY_MARKS**

Use **XS_SHOW_EMPTY_MARKS** to control the behavior of manually added marks and notes in drawings when the content in the properties is not defined for the object type you have selected in the drawing.

This advanced option was already introduced in **Tekla Structures 2023 SP5**.

**XS_DRAWINGS_USE_CAP_HEIGHT_FOR_FONT_HEIGHT**

The new model-specific advanced option **XS_DRAWINGS_USE_CAP_HEIGHT_FOR_FONT_HEIGHT** controls the font height in drawings. When CAP height (TRUE) is used, the text height set in the Tekla Structures drawing is the same when you open the drawing in Autodesk AutoCAD or Bentley MicroStation, for example.

This advanced option is located in the **Drawing properties** category of the **Advanced options** dialog box.

**XS_USE_PROJECT_LOCATION_IN_IFC2X3_IMPORT**

When inserting an IFC2x3 reference model that has a project location available, you can now enable the project location by setting the new model-specific advanced option **XS_USE_PROJECT_LOCATION_IN_IFC2X3_IMPORT** to TRUE. When this advanced option is set to TRUE, the project location is applied and the reference model is inserted away from the Tekla Structures model origin. The default value is FALSE.

This advanced option is located in the **Import** category of the **Advanced options** dialog box.

**XS_DSTV_NO_SAWING_ANGLES_FOR_PROFILES_NEEDED**

If you do not want to write sawing angles to the NC file header for profiles, set the new model-specific advanced option **XS_DSTV_NO_SAWING_ANGLES_FOR_PROFILES_NEEDED** to TRUE. This
advanced option was added to support the identical functionality for plates, and cases where the AK block is preferred by a DSTV viewer or NC machine. The default value `FALSE` means that sawing angles will be written to the NC file header for profiles.

This advanced option is located in the **CNC** category of the **Advanced options** dialog box.

**XS_PART_CUT_INHERIT_UDAS_FROM_CUTTING_PART**

Use the **XS_PART_CUT_INHERIT_UDAS_FROM_CUTTING_PART** advanced option to prevent the copying of user-defined attributes (UDAs) from the original cutting part to the anti-material cutting part when you use the **Part cut** command.

The default value in Tekla Structures 2024 is `FALSE`. When set to `FALSE`, the UDAs are not copied to the antimaterial part.

This advanced option was already introduced in Tekla Structures 2023 SP8. Note that in Tekla Structures 2023 SP8 the default value of the advanced option was `TRUE`.

**XS_REBAR_END_SPECIFIC_UDA_METHOD**

You can now use the advanced option **XS_REBAR_END_SPECIFIC_UDA_METHOD** to control the generation of the **End preparations** user-defined attributes of rebar set end detail modifiers.

The rebar coupler and anchor tools also comply with the setting of this advanced option when they add UDAs to reinforcing bars.

If you set this advanced option to **START_AND_END**, which is the default value, start leg and end leg UDAs are created. These UDAs have a `_START` or `_END` suffix, for example, `METHOD_START`.

The **SHORT_AND_LONG** value creates short leg and long leg UDAs. These UDAs have an `_S` or `_L` suffix, for example, `THREADED_LENGTH_L`.

This advanced option overrides the suffixes defined in the RebarCoupler.Udas.dat file. Regardless of which suffixes are defined in the file, they will be replaced based on the value of this advanced option.

**XS_REBAR_VERTICAL_FACTOR**

This new advanced option must be set in an initialization (.ini) file. It sets a factor that can be used to fine-tune which bars in rebar sets are considered horizontal or vertical.

**XS_HIGH_ACCURACY_TRIMBIM_EXPORT**

Use this new advanced option, **XS_HIGH_ACCURACY_TRIMBIM_EXPORT**, to have high solid accuracy in .tekla and .trb file exports, and thus to enable, for example, corner rounding in profiles.

Note that the higher solid accuracy affects Tekla Structures performance.
The default value is **TRUE**.

### 27.2 Changed advanced options

**XS_REBAR_GEOMETRY_TYPE_IN_NUMBERING**

The advanced option `XS_REBAR_GEOMETRY_TYPE_IN_NUMBERING` was introduced in Tekla Structures 2023 SP1. You can use it to specify how the geometry of reinforcing bars is taken into account in numbering and which type of bar geometry is used when bars are compared with each other. Now, in Tekla Structures 2024, the default value of this advanced option has been changed from **POLYLINE** to **FABRICATION**.

**XS_DRAWING_CHANGE_HIGHLIGHT_COLOR**

You can use the advanced option `XS_DRAWING_CHANGE_HIGHLIGHT_COLOR` to change the highlight color of the automatic change symbols. In addition to single color index values, you can now enter the RGB value of a specific custom RGB color. For an RGB color, enter three numeric values separated by spaces (each value in the range 0 to 255). For example, for a specific shade of green, enter `0 220 50`.

### 27.3 Obsolete advanced options

**Advanced options related to DGN export**

The following advanced options related to the DGN export do not work and have been removed from Tekla Structures 2024:

- `XS_DGN_EXPORT_PART_AS` - This advanced option was used to specify how Tekla Structures exports solid objects to the DGN format.
- `XS_EXPORT_DGN_ROUND_SEGMENTS` - This advanced option was used to define the number of segments Tekla Structures uses to display round tubes.
- `XS_EXPORT_DGN_USE_CLASS_AS_COLOR` - This advanced option was used to set the color for exported parts by the part class.
- `XS_EXPORT_DGN_INCLUDE_INNER_CONTOUR` - This advanced option was used to include or exclude inner contours of tubes in the DGN exports.

**Advanced options defining Special hatch color**

The following advanced options that were used for defining the **Special** hatch color for printing and export have been removed from Tekla Structures 2024:

- `XS_HATCH_SPECIAL_COLOR_ACI`
- `XS_HATCH_SPECIAL_COLOR_R`
You can now define custom RGB colors and use those in hatches instead. Models created with Tekla Structures versions older than 2024 containing values for the removed advanced options are still supported.

**Advanced options defining colors**

The following advanced options have been replaced by new advanced options that also accept RGB values in Tekla Structures version 2024 and newer:

- **XS_POP_MARK_COLOR** - Replaced by **XS_POP_MARK_COLOR.RGB**
- **XS_SECTION_LINE_COLOR** - Replaced by **XS_SECTION_LINE_COLOR.RGB**
- **XS_SHORTENING_SYMBOL_COLOR** - Replaced by **XS_SHORTENING_SYMBOL_COLOR.RGB**

**XS_HELP_PATH**

This advanced option is no longer needed. It was used to specify the location of the help files in the .chm (Microsoft Compiled HTML Help) format, which was used for some components. Some of the old component .chm files are still used, but the path is read from the registry, not from this advanced option.

### 27.4 List of obsolete advanced options across Tekla Structures versions

The list of obsolete advanced options provides information about the advanced options that have become obsolete in Tekla Structures in version 2018 and newer.
Upgrade guide from Tekla Structures 2023 to Tekla Structures 2024

Administrator’s release notes are intended to provide advanced users with instructions on how to apply the additional customizations available in a new Tekla Structures version.

28.1 Administrator’s release notes: Model templates in version update

**NOTE** If you have model templates in Tekla Warehouse, remember to update them as well.

**Update model templates**

1. Open Tekla Structures 2024.
2. Create a new model using an existing model template.
3. Give the model the same name as in the previous Tekla Structures version.
4. Open a 3D view.
5. Diagnose and repair the model.
6. Create a project thumbnail, or add a custom image named thumbnail.png in the model folder.

   The preferred size of the image is 120 x 74 pixels.
7. Save the model.
   If you do not save the model, a message that warns about the model being created with a previous version might be shown.

8. Save the model as a model template.

9. Include the needed catalog files and subfolders from the model folder, and click OK.
10. Manually remove all *.db files (environment database, options databases) from the model folder.

The *.bak, *.log and xs_user files are automatically removed from the model folder.

The .idrm files (db.idrm and xslib.idrm) should be kept as they are part of the model.

The model template is saved in the location specified by XS_MODEL_TEMPLATE_DIRECTORY.

You now have a sample image for your model template. The Applications & components catalog is now also in order and easy to use.
28.2 Administrator's release notes: Applications & components catalog maintenance

Keep the Applications & components catalog organized and usable.

Set XS_COMPONENT_CATALOG_ALLOW_SYSTEM_EDIT to TRUE to be able to edit the Applications & components catalog definition files that are located in the XS_SYSTEM folders.

Check and fix the following:

1. Add items to groups

Check the Ungrouped items group and add the items to the appropriate group.

2. Check the logs for errors

The Applications & components catalog shows the message log button in the lower-right corner of the catalog if there are errors or warnings, such as errors in the catalog definition files.

If there are references to missing plug-ins, go to the referred ComponentCatalog.xml and remove the references manually:
Thoroughly test that these changes do not create any further errors or change the structure of your Applications & components catalog. Check at least the Ungrouped items and Legacy catalog groups.

As in the example above, there might be errors for:

- CatalogPluginComponentItem?CopyModelDirectoryPlugin
- CatalogPluginComponentItem?SaveAsModelTemplatePlugin

3. Hide all non-related applications and components from roles

1. In the Ungrouped items catalog, select Show hidden items at the bottom.
2. Right-click an application or a component and select Hide / Unhide.

4. Create custom thumbnails

Publish a component in the Applications & components catalog

You might need to use the same component with different settings in different cases. To easily use the component, you can define the settings for each case and publish the component in the catalog. This feature can be useful for some roles.

28.3 Administrator's release notes: Ribbon updates

If you have customized the ribbon, the changes made in the new Tekla Structures version are not visible. Check the changes and add them to your customized ribbon.
Check the changes
Compare the original ribbon with the changes that you have made.
You can check the changes to see what has been added and removed, and what has been moved to different tabs.

Add changes to your customized ribbon
If you have customized the ribbon, update the ribbon to include the changes made in the new Tekla Structures version.

1. On the Steel tab, add the following new options to the Bolt menu item:
   - By face
   - By parts and face
   - By parts and points

2. Update the Trimble connect tab.
   a. Remove the ToDos menu item.
   b. Add the BCF topics menu item.

28.4 Administrator's release notes: New DGN export for drawings
Tekla Structures 2024 now supports the export of drawings in the Microstation 2D DGN v8 format.

For more information about these improvements, see New DGN export option for drawings (page 39) in the Tekla Structures 2024 release notes.

Update your standard files if you want to use the new options and features.

1. Create a new .dwgsetting standard file with the settings for DGN export.

2. To add the DGN file type to Document manager, add the following line to the DocumentManagerFileDocumentSettings.txt file located in your model, project, or firm folder:

```plaintext
."Plotfiles"*.dgn|false
```
28.5 Administrator's release notes: New categories in Drawing content manager

It is now possible to customize the visible content of the sub-assemblies and reference objects in the Drawing content manager.

For more information about these improvements, see Other improvements in drawings (page 50) in the Tekla Structures 2024 release notes.

Update your standard files if you want to use the new options and features.

1. Create the needed categories in `<model>\attributes\DrawingContentManagerCategories_<username>.xml`.
   - Add `translation:albl_` before the attribute name added to Drawing content manager.
   - Attributes for sub-assemblies and reference objects are already localized in the common and default environments.

2. Save a copy of the file as `<model>\attributes\DrawingContentManagerCategories.xml`.

3. Copy the `<model>\attributes\DrawingContentManagerCategories.xml` file to any folder in the XS_SYSTEM path in the environment.

28.6 Administrator's release notes: New custom colors in drawings and printing line property improvements

You can now define an unlimited number of custom RGB colors for drawing objects.

For more information about these improvements, see New custom colors in drawings and printing line property improvements (page 12) in the Tekla Structures 2024 release notes.

Enable the new color palette dialog box

Tekla Structures 2024 introduces a new color palette dialog box for defining custom RGB colors.

The new color palette dialog box is used in:

- Drawing, view, and object-level properties
- Line properties in printing
- Template Editor templates
- The Color palette editor
1. Add an example color palette to your environment.
   a. In drawing mode, go to the File menu and click Editors --> Color palette editor.
   b. Enter a name for the color palette file in the Custom box, and click Save.
      The color palette files are saved as *.ColorPalette.xml files in the \attributes folder under the current model folder.
   c. Copy the *.ColorPalette.xml file to an environment folder.
2. Create a printing settings file that uses the example color palette.
   For more information, see .
3. Save new or updated settings file.
4. Copy the *.PdfPrintOptions.xml file from the model folder to an environment folder.

NOTE PdfPrintOptions.xml is used as a standard settings file.

Update advanced options for custom RGB colors
There are new, changed, and obsolete advanced options related to custom RGB colors.
For more information, see Changes in advanced options (page 138).
1. If you want to use a value other than the default value, add or update these new advanced options in your .ini file:
   • XS_SHORTENING_SYMBOL_COLOR_RGB
      This advanced option replaces the obsolete XS_SHORTENING_SYMBOL_COLOR advanced option.
   • XS_SECTION_LINE_COLOR_RGB
      This advanced option replaces the obsolete XS_SECTION_LINE_COLOR advanced option.
   • XS_POP_MARK_COLOR_RGB
      This advanced option replaces the obsolete XS_POP_MARK_COLOR advanced option.
2. Check whether your environment uses the following changed advanced option and update it if needed:
   XS_DRAWING_CHANGE_HIGHLIGHT_COLOR
3. Remove the following obsolete advanced options from your environment:
   • XS_POP_MARK_COLOR
• XS_SECTION_LINE_COLOR
• XS_SHORTENING_SYMBOL_COLOR
• XS_HATCH_SPECIAL_COLOR_ACI
• XS_HATCH_SPECIAL_COLOR_R
• XS_HATCH_SPECIAL_COLOR_G
• XS_HATCH_SPECIAL_COLOR_B

Update templates for custom RGB colors
The color picker in the Template Editor no longer uses index color values for the standard colors. If you created templates using RGB colors while testing Tekla Structures before the final release, you must update your templates or create new templates.

To make the RGB colors that are defined in RGB color fields (fields that end in color_argb) work, change the value of all index color fields (fields that end in color) to -1.

Update old drawing property files containing old color codes
There are old drawing property files with old color codes in environments, which are shown incorrectly in the drawing property pane. If you see RGB 0,0,0 in the drawing property pane for a color, the property file is old and should be updated.
The old color codes are numbers from 1 - 8, and they are no longer supported even if correct colors are visible in drawings. Replace the old color codes with the correct color codes.

You can search the outdated color codes from the attribute files by searching for example "_color 3". The name of the attribute can be in US or British style (color, colour). For example, use Notepad ++ search to find the problematic property files, then check the file name extension of the property files, do the fixing in the drawing property pane, and save the property files.

The problematic property files are related to drawings only. Potentially affected files:

- Object level property files
- General arrangement drawing drawing-level property files
- Drawing view-level property files

28.7 Administrator's release notes: Reinforcement improvements

For more information about these improvements and changes, see Reinforcement improvements (page 79) in the Tekla Structures 2024 release notes.

Update your standard files if you want to use the new options and features.

Update Rebar shape manager rules

The rules for the recognition of circular bars have changed. If you do not use the default environment, update the Rebar shape manager rules in your environment.

In previous versions, the recognition of circular bars was based on the bar creation method. Now all bars, regardless of their creation method, are recognized based on their geometry.

1. Add a shape definition rule to recognize circular bars.
   a. In the shape catalog, select a circular bar shape.
   b. Add the following bending shape rule:

   \[
   \text{Arc angle} \ 1 \ >= \ 360
   \]

2. Update the curved bar shape definition to prevent it from recognizing circular bars as curved bars.
   a. In the shape catalog, select a curved bar shape.
   b. Add the following geometry condition to the shape bending rules:
Making these changes also updates the version number of the RebarShapeRules.xml file.

**Update the environment for smoothing factor for rebar sets**
A new user-defined attribute, **Smoothing factor**, is now available for rebar sets on the Rebar set UDA tab. This setting is useful when leg surfaces in complex geometry parts do not produce the desired bar geometry.

If you do not use the objects_rebar_set.inp file from the common environment, merge your file with the one in the common environment.

**Update user-defined attributes of bar ends**
To control which user-defined attributes are created for reinforcing bars, you can now use the new **XS_REBAR_END_SPECIFIC_UDA_METHOD** advanced option.

It has two values: `START_AND_END` and `SHORT_AND_LONG`. **This change is useful when leg surfaces in complex geometry parts do not produce the desired bar geometry.**

If you want to change the value to `SHORT_AND_LONG` for the users in your area, add that setting to your environment-specific .ini file.

**NOTE** As a result of this change, the RebarCoupler.UdasSL.dat file has become redundant and has been removed from the environments.

**Update rebar mesh sizes in rebar_config.inp**
To fix an issue with multiple spacings not being shown correctly in rebar mesh size in drawing marks, the template for rebar mesh size was changed in the rebar_config.inp in the common environment.

In `RebarMeshSize`, `CC_PITCHING_LONG` and `CC_PITCHING_CROSS` were changed to `CC_LONG` and `CC_CROSS`.

**Before:**

```plaintext
// Template for rebar mesh size
RebarMeshSize="%CC_DIAMETER_LONG%/%CC_DIAMETER_CROSS%/CC_PITCHING_LONG%/CC_PITCHING_CROSS%/LENGTH%/WIDTH%"
```

**After:**

```plaintext
// Template for rebar mesh size
RebarMeshSize="%CC_DIAMETER_LONG%/%CC_DIAMETER_CROSS%/CC_LONG%/CC_CROSS%LENGTH%/WIDTH%"
```

If you do not use the rebar_config.inp from the common environment, update your file for these changes.
1. Open your rebar_config.inp file in a standard text editor.
2. Make the following changes:
   • Change CC_PITCHING_LONG to CC_LONG.
   • Change CC_PITCHING_CROSS to CC_CROSS.

28.8 Administrator's release notes: Improvements in drawing dimensions

For more information about these improvements, see Improvements in drawing dimensions (page 45) in the Tekla Structures 2024 release notes. Update your standard files if you want to use the new options and features.

Updates for new rounding options in dimension properties
The dimension properties in automatic and manual dimensioning now have three new rounding options: 2.50, 5.00, and 10.00. These new options work only when the unit is mm.

To use the new rounding options in your area as the local standard, update the drawing dimensioning settings and manual dimensioning default values to use the new options.

28.9 Administrator's release notes: Updates in the Compare commands
The Compare command has been improved to make it easier to understand why two parts, assemblies, or cast units get different position numbers.

A log that lists all the differences between the parts now opens automatically. A tree view that lists all the relevant contents of an assembly and cast unit has also been added.

For more information about these improvements, see Other modeling improvements (page 76) in the Tekla Structures 2024 release notes.

Update custom report templates
If you do not use the TS_Report_Assembly_Comparison.rpt file from the common environment, you must update your report template.
1. If you have customized the TS_Report_Assembly_Comparison.rpt file in your environment, edit the file before you copy it to your environment.
   a. Browse to the Environments\common\system folder.
   b. Open the TS_Report_Assembly_Comparison.rpt file in a standard text editor.
   c. Make the same changes that you made in your custom TS_Report_Assembly_Comparison.rpt file.

   For example, if you changed the recommended default values for a dialog box, such as the default columns for the attributes of objects and the sort order, make those changes again.

   Name and Position number are used for all object types except Weld. The Weld object type uses Type1 and Size1.

2. Copy the TS_Report_Assembly_Comparison.rpt file from the Environments\common\system folder to a folder in your environment.

28.10 Administrator's release notes: New IFC property set definition - control all hidden, hard-coded, and buildingSmart properties

New functionalities and usability improvements have been added to the Property set definitions dialog box to make the tool more powerful for creating property sets.

For more information about these improvements, see New IFC property set definition - control all hidden, hard-coded, and buildingSmart properties (page 86) in the Tekla Structures 2024 release notes.

Update your standard files if you want to use the new options and features.

Copy files from the common environment
If you do not use files from the common\inp folder in your environment, copy files from the common environment to your environment.

1. Copy the following files from the common\inp folder in the common environment to your own folder defined by the XS_INP advanced option:
   • IfcPropertySetConfigurations.xsd
   • Bridge view default properties.xml
   • Coordination view default properties.xml
   • Design transfer view default properties.xml
2. Copy the \Environments\common\inp\PropertySets folder from the common environment to your own folder defined by the XS_INP advanced option.
   This folder contains XML files for buildingSMART properties. Do not edit these property sets.
   The folder contains the following files:
   - Pset_Common_IFC2x3 (xml)
   - Pest_Common_IFC4 (xml)
   - Pset_Common_IFC4x3 (xml)
   - Pest_Others_IFC2x3 (xml)
   - Pset_Others_IFC4 (xml)
   - Pset_Others_IFC4x3 (xml)
   - Pset_Performance_IFC4 (xml)
   - Pset_Performance_IFC4x3 (xml)
   - Pset_Quantities_IFC4 (xml)
   - Pset_Quantities_IFC4x3 (xml)

Create a new filter file for the IFC property set export
1. Browse to the \Environments\common\system folder.
2. Open the standard.IFCObjGrp file in a standard text editor.
3. Create new custom object filters if needed.
4. Copy from <model>\attributes\*.IFCObjGrp to any folder in the XS_SYSTEM path in your environment.
**28.11 Administrator's release notes: Arial is the new default font in drawings**

The default font setting for texts, value fields, and marks in drawings has been changed from Arial Narrow to Arial in the Common and Default environments.

For more information about this change, see Other improvements in drawings (page 50) in the Tekla Structures 2024 release notes.

**Update your environment for the font change**

1. Change "Arial Narrow" to "Arial" in all files in your environment.

   For example, you can use the **Find in Files** option in Notepad++ to replace "Arial Narrow" with "Arial" in all files in your environment folder.

   ![Find in Files dialog box](image)

2. Check and update your templates and reports to ensure that text fits into the reserved areas after you change the font.

   Check these file types:
   - Templates: *.tpl
   - PDF reports: *.pdf.rpt
   - HTML reports: *.html.rpt
28.12 Administrator's release notes: New font height metric option for printing and exporting drawings: CAP height
You can now use CAP height as the font height metric in Tekla Structures drawings.
For more information about this improvement, see New font height metric option for printing and exporting drawings: CAP height (page 35).

28.13 Administrator's release notes: Changes to IFC property sets for Tekla PowerFab
IFC property sets for Tekla PowerFab have been updated and renamed in the common environment in Tekla Structures 2024.
These files have been removed from the ..\Environments\common\system folder:
• Esti_modelling.IFCExportPlugin.MainDialog.xml
• EPM_Copes.xml (this file is not used because it is not in the AdditionalPSets folder)
• EPM_Burns.xml (this file is not used because it is not in the AdditionalPSets folder)
• \AdditionalPSets\EPM.xml
These files have been added to the ..\Environments\common\system folder:
• Tekla PowerFab.IFCExportPlugin.MainDialog.xml
• \AdditionalPSets\Tekla PowerFab.xml
Import is more complete with the following US Custom properties and if they want to include them they will need to install the US Custom Variables or have the custom variables added to their environment.
• CUSTOM.WELD_LENGTH_INT1 must be named INTERMITTENT WELD ACTUAL LENGTH 1 to map
• CUSTOM.WELD_LENGTH_INT2 must be named INTERMITTENT WELD ACTUAL LENGTH 1 to map
• CUSTOM.QTY_BURNS can be named anything as it will not automatically map - PowerFab importer will map as necessary
• CUSTOM.QTY_COPES can be named anything as it will not automatically map - PowerFab importer will map as necessary

Property sets are not currently possible to translate with translation strings (albl,...). You may want to have your own copy because of this.

**Update your environment for changes to IFC property sets for Tekla PowerFab**

If you use Tekla PowerFab and IFC property in your area, update your environment for the changes.

1. Check and test the files in the ..\Environments\common\system folder.
2. Update and rename the files in your environment if needed.
   Rebrand files from EPM to TeklaPowerFab.

### 28.14 Administrator’s release notes: Integrated link to Tekla Tedds for simple connections

Ribbon commands for Tekla Tedds Integrator in Tekla Structures 2024 allow you to link Tekla Tedds calculation documents to your Tekla Structures model. The integration reduces the amount of manual work that the detailer or engineer has to do in Tekla Structures, which improves productivity.

For more information about these improvements, see Integrated link to Tekla Tedds for simple connections (page 118).

**Enable the user interface for Tekla Tedds Integrator**

The Tekla Tedds Integrator extension is included in Tekla Structures 2024, but parts of the user interface are not visible by default. You must enable the user interface for the feature in the environment.

By default, only these parts of the Tekla Tedds Integrator user interface are visible:

• The Tekla Tedds Integrator commands in the **Applications & components** catalog.

• The **Tedds Documents** Representation option in the **View Properties** dialog box. This representation shows which model elements have Tekla Tedds documents attached.

These parts of the Tekla Tedds user interface are not visible until you enable the user interface for the feature in the environment:
• The Tekla Tedds tab on the ribbon
• The Tekla Tedds tab in the user-defined attributes dialog box.

To enable the user interface for Tekla Tedds Integrator:

1. Add %XSDATADIR%\environments\common\system\Analysis to the XS_SYSTEM path in an env_<environment>.ini or role_<role>.ini file.
2. Update the Applications & components catalog in one of these ways:
   • Group Tekla Tedds tools in the Applications & components catalog.
   • Hide Tekla Tedds tools in Applications & components catalog if Tekla Tedds is not supported in your area.

28.15 Administrator's release notes: System and folder changes

Dll Com Analysis removed
libcom api is no longer available in Tekla Structures 2024.
Alternatives are provided in Tekla Warehouse for the analysis and design links, such as STAAD, ETABS, Robot, and SAP2000.

Tekla internal bitmaps moved to ..\2024.0\bin\Env\Bitmaps
Tekla internal bitmaps have been moved to the ..\2024.0\bin\Env \Bitmaps folder.
Replace %XSDATADIR%\bitmaps with %DAK_BMPPATH% in .ini files for all environments and roles.

Example
Previously, DAK_BMPPATH was defined in env_<environment>.ini files like this:

```plaintext
set DAK_BMPPATH=%XSDATADIR%\environments\Germany\bitmaps;%XSDATADIR%\bitmaps
```

It should now be defined like this:

```plaintext
set DAK_BMPPATH=%XSDATADIR%\environments\default\bitmaps;%DAK_BMPPATH%
```
Tekla internal instructor pane texts moved to ..\2024.0\bin\Env\InstructorContent

Tekla internal instructor pane texts moved to the ..\2024.0\bin\Env\InstructorContent folder.

No changes are needed in environments. Tekla Structures searches for internal instructor pane texts from the new folder and the folder defined in XS_SYSTEM in the same way as before.

Standard and translation files for Tekla internal applications moved to bin folder

Previously, standard and translation files for Tekla internal applications were in the ...\Environments\common\system folder. Now they are in the ...\bin\Env\Common\System and ...\bin\applications\rpc\system folders.

No changes are needed in environments. Tekla Structures searches for standard and translation files from the new folder and the folder defined in XS_SYSTEM/XS_MESSAGES_PATH in the same way as before.

Do not modify these files. If a different standard file is needed, it should be located in the folder defined in XS_SYSTEM, XS_FIRM, or XS_PROJECT.

Deprecation notice for removal of support for XS_SYSTEM and isolated files in extensions folders

Previously, translation files for the Applications & components catalog (*_ComponentCatalogDefinitions.ail files) were read from folders defined by the XS_SYSTEM advanced option and all folders in %XSDATADIR%\common\extensions. Now these files are read from the path defined by the XS_MESSAGES_PATH advanced option and %XSDATADIR%\common\extensions\messages.

Update your extension installers so that translation files for the Applications & components catalog (*_ComponentCatalogDefinitions.ail files) are installed to %XSDATADIR%\common\extensions\messages.

.tsep installers removed from environment installers

The main environment content is now installed without .tsep installers. Content and functionality in environments remains the same as earlier.

Some environments have extensions that are added as .tsep installers to the Extensions\To be installed folder and installed the next time that Tekla
Structures starts. Environment content is not visible in the Extension manager.

28.16 Administrator's release notes: Miscellaneous general improvements

New configuration for Tekla Platform partners
A new Tekla Platform configuration has been added for Tekla Platform partners.
To start using the new configuration, make these changes in your environment.

1. If you use a bypass.ini file to define the default license when you start Tekla Structures, add the following line to the file:

```
rem set XS_DEFAULT_LICENSE=PLATFORM
```

2. Update the Tekla Structures version number in paths to
   TeklaStructures.exe, bypass.ini, and user settings files.

Licensing improvements
To help users to resolve licensing issues independently so that they can continue working as fast as possible, these licensing improvements have been made.

• A message is now shown to users when Tekla Structures cannot start because of clock inaccuracy. If time synchronization settings are managed at the organization level in your company, ensure that the time zone, UTC time, and local time are consistent with each other for all users. For more information, see Tekla Structures cannot start because of clock inaccuracy.

• Previously, after updating from Windows 10 to Windows 11, or installing some other Windows updates, some subscription licenses were no longer available or Tekla Structures did not start. Tekla Structures licenses are now more stable after Windows updates.
Changes in the Inquire Cast Unit report
In the Inquire Cast Unit report, the Parts listing has been changed to show PART_POS instead of ASSEMBLY_POS in the first column. The default sorting direction has also been changed to ascending.

If you use a custom copy of TS_Report_Inquire_Cast_Unit.rpt, update the file.
1. Replace ASSEMBLY_POS with PART_POS.
   
   Before:

   ```
   formula = "GetValue("ASSEMBLY_POS")";
   ```

   After:

   ```
   formula = "GetValue("PART_POS")";
   ```

2. Change the value of sortdirection to ASCENDING.
   
   Before:

   ```
   sortdirection = NONE;
   ```

   After:

   ```
   sortdirection = ASCENDING;
   ```

Flange slope ratio added to UPN profiles
UPN profiles in the default environment now have a flange slope ratio defined. This change fixes problems when using components, such as stiffeners with bad shape.

If you use a custom profile catalog, add a flange slope ratio for each UPN profile, depending on the size:
- For UPN 300 and smaller: 0,08
- For UPN 320 and large: 0,05.

Improved visualization for non-foldable and broken chamfers
The visualization for non-foldable and broken chamfers in the model view has been improved.

When the XS_DRAW_CHAMFERS_HANDLES advanced option is set to CHAMFERS, non-foldable and broken chamfers are shown in the model view as follows:
- Non-foldable chamfers are shown in yellow. Whether a chamfer is non-foldable depends on the plate thickness and the chamfer parameters. An example of a non-foldable chamfer is a square chamfer that is too tight to fit a curve into.
• If the solid cannot be created for the polybeam, all the chamfers are shown in red. Only stick representation is shown for the part in the model view.

The default value of the XS_DRAW_CHAMFERS_HANDLES advanced option is HANDLES. Check the value of the XS_DRAW_CHAMFERS_HANDLES advanced option in your environment and update it if needed.

Changes to UDA tabs and default values

A Structural Information UDA tab was added for items and concrete items in the common environment. The default values of all drop-down lists on the tab are now empty.

Previously, the default values were set to a specific value. For example, the default value for the Load bearing drop-down list was No.

NOTE If you open a model that was created with a previous Tekla Structures version in Tekla Structures 2024, option attributes that have a value other than the default show an incorrect value.

If you do not use the objects_structural.inp file or the IfcPropertySetConfigurations.xml files from the common environment, update your custom files for these changes.

1. Add these lines to your objects_structural.inp file:

```plaintext
/**************************************************************************
/* Item (BREP) attributes                                                  */
/***************************************************************************/
item(0,"j_Item")
{ tab_page("StructuralInformation","jd_StructuralInformation",15) modify(1) }

/**************************************************************************
/* Concrete item (BREP) attributes                                         */
/***************************************************************************/
concrete_item(0,"j_Concrete_Item")
{ tab_page("StructuralInformation","jd_StructuralInformation",15) modify(1) }
```

2. In your objects_structural.inp file, move Unset to be the first value in the option attributes for drop-down lists on the StructuralInformation tab.
Before

```
{  
  attribute("REF_ID", "j_user_ref_id", string, "%s", no, none, "0.0", "0.0")  
  {  
    value("", 0)  
  }  
  attribute("RENOVATION_STATUS", "j_Renovation_status", option,"%s", no, none,"0.0", "0.0"  
  {  
    value("j_New", 0)  
    value("j_Existing", 0)  
    value("j_Demolish", 0)  
    value("j_Temporary", 0)  
    value("j_Other", 0)  
    value("j_Unknown", 0)  
    value("j_Uunset", 2)  
  }  
  attribute("IS_EXTERNAL", "j_Is_external", option,"%s", no, none,"0.0", "0.0")  
  {  
    value("j_No", 0)  
    value("j_Yes", 0)  
    value("j_Uunset", 2)  
  }
}
```

After

```
{  
  attribute("REF_ID", "j_user_ref_id", string, "%s", no, none, "0.0", "0.0")  
  {  
    value("", 0)  
  }  
  attribute("RENOVATION_STATUS", "j_Renovation_status", option,"%s", no, none,"0.0", "0.0"  
  {  
    value("j_Uunset", 2)  
    value("j_New", 0)  
    value("j_Existing", 0)  
    value("j_Demolish", 0)  
    value("j_Temporary", 0)  
    value("j_Other", 0)  
    value("j_Unknown", 0)  
  }  
  attribute("IS_EXTERNAL", "j_Is_external", option,"%s", no, none,"0.0", "0.0")  
  {  
    value("j_Uunset", 2)  
    value("j_No", 0)  
    value("j_Yes", 0)  
  }
}
```

3. Check the default values in your custom IfcPropertySetConfigurations.xml files and update them if needed.
Prevent the copying of UDAs from the cutting part to the cut part
You can now use the `XS_PART_CUT_INHERIT_UDAS_FROM_CUTTING_PART` advanced option to prevent user defined attributes (UDAs) from being copied to the cut part when using the **Part cut** command.

When the value of the `XS_PART_CUT_INHERIT_UDAS_FROM_CUTTING_PART` advanced option is **FALSE**, the **Part cut** command does not copy UDAs from the cutting part to the cut part.

The default value of the `XS_PART_CUT_INHERIT_UDAS_FROM_CUTTING_PART` advanced option is **FALSE**.

Finish field in Floor Layout tool
You can now define the **Finish** property for layer parts on the **Layer** tab of the Floor Layout tool.

Update your attribute files if you want to use the new property.

New objects supported in Drawing property pane
New object types are available in the Drawing property pane.

Some previous attribute files, such as `Symbol.txt` and `RevisionMark.txt`, might not work properly.
1. Test these new object types and attribute files.
   - For example, create a symbol, select it, and load a new attribute file.
2. If the attribute file does not work properly, update the attribute file.

Configuration file for Multi-report generator
Multi-report generator is added as extension in environment installers.

The `MultiReportGenerator.inp` configuration file for filtering reports can be localized. An example `MultiReportGenerator.inp` file is included in the default environment.

**Example** `MultiReportGenerator.inp` file

```
| Excel|excel
| ID|ID
| IFC|IFC
| Inquire report|Inquire
```
Tekla Structures searches for the MultiReportGenerator.inp file in the folders defined by the XS_PROJECT, XS_FIRM, and XS_SYSTEM advanced options.

1. Create a MultiReportGenerator.inp configuration file in your environment.
   
The syntax is: [Visible text] | [String found in name of the report]

   Example MultiReportGenerator.inp file

| Excel|excel
|ID|ID
|IFC|IFC
|Inquire report|Inquire
|PDF|PDF
|TeklaPowerFab|TeklaPowerFab

2. Save the file in a folder that is specified in the XS_SYSTEM advanced option.

Enhancements in the Management Console for Tekla Model Sharing

If you are an administrator in the Management Console for Tekla Model Sharing, these new enhancements help you to manage your organization's shared models more precisely and efficiently.

Default model data storage location

You can now select the default model data storage location for shared models in your organization. The default model data storage location defines the region where Tekla Model Sharing model data is stored.

The default location is automatically selected as the model data storage location when users share a model. Users can only select a different model data storage location if you allow them to do so.

For more information, see Manage organization settings in the Management Console.

Advanced filtering

You can now define advanced filter criteria in the Management Console for Tekla Model Sharing to more precisely search for users and models.

For more information, see Introduction to the Management Console user interface.
Set user/role for multiple models
The Management Console for Tekla Model Sharing now has an action to add a user to multiple models at the same time.
For example, if the previous owner of several shared models leaves the company, you can add a user as a new owner for all of that user's shared models.
For more information, see Manage users in shared models in the Management Console.

28.17 Administrator's release notes: Steel settings
The following customization settings only apply to the steel user group.

Administrator's release notes: Steel components
There are several improvements in steel components in Tekla Structures 2024.
Update your standard files if you want to use the new options and features.
For more information about these improvements, see Improvements in components (page 130) in the Tekla Structures 2024 release notes.

28.18 Administrator's release notes: Concrete settings
The following customization settings only apply to the concrete user group.

Administrator's release notes: Concrete components
There are several improvements in concrete components in Tekla Structures 2024.
Update your standard files if you want to use the new options and features.
For more information about these improvements, see Improvements in components (page 130) in the Tekla Structures 2024 release notes.
Environment-specific Tekla Structures localization release notes introduce new and changed features in the new Tekla Structures version from the localization point of view. It lists the features that have been localized in your environment and also helps you in your own customization tasks. The localization release notes are supplied by the localization teams at your local area and reseller offices.
30 Disclaimer

© 2024 Trimble Inc. and affiliates. All rights reserved.

Use of the Software and of this Software Manual are governed by a License Agreement which determines whether you are an authorized user of the Software and the Software Manual. The warranties and disclaimers set forth in the License Agreement apply to the Software and the Software Manual. Neither the Trimble entity granting the license nor any of its affiliates assume responsibility that the text is free of technical inaccuracies or typographical errors. The right to make changes and additions to this manual is reserved.

Trimble and certain product names are registered trademarks of Trimble Inc. in the United States, the European Union and other countries and may have similar statutory protections. Trademarks of third parties are not mentioned in this Manual to suggest an affiliation with or endorsement by their owners.

Elements of the software described in this Manual may be the subject of pending patent applications in the European Union and/or other countries.

Portions of this software:

EPM toolkit © 1995–2006 Jotne EPM Technology a.s., Oslo, Norway. All rights reserved.

Portions of this software make use of Open CASCADE Technology software. Open Cascade Express Mesh Copyright © 2019 OPEN CASCADE S.A.S. All rights reserved.

FLY SDK - CAD SDK © 2012 VisualIntegrity™. All rights reserved.

This application incorporates Open Design Alliance software pursuant to a license agreement with Open Design Alliance. Open Design Alliance Copyright © 2002–2020 by Open Design Alliance. All rights reserved.

CADhatch.com © 2017. All rights reserved.

RapidXml C++ library © All rights reserved.

FlexNet Publisher © 2016 Flexera Software LLC. All rights reserved. This product contains proprietary and confidential technology, information and creative works owned by Flexera Software LLC and its licensors, if any. Any use, copying, publication, distribution, display, modification, or transmission of such technology in whole or in part in any form or by any means without the
prior express written permission of Flexera Software LLC is strictly prohibited. Except where expressly provided by Flexera Software LLC in writing, possession of this technology shall not be construed to confer any license or rights under any Flexera Software LLC intellectual property rights, whether by estoppel, implication, or otherwise.

To see the third party open source software licenses, go to Tekla Structures, click File menu --> Help --> About Tekla Structures --> 3rd party licenses and then click the option.